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Stencil-Art Definitions

Untitled Fiie

“UNTITLED" is the name of every new sign before saving. An UNTITLED sign
does not exist in the memory and signs cannot be recorded with this name. If you
want to save files, you must choose Save As or answer “Yes” when Stencil-Art is
prompting to save and give the file 2 usable name. There is no Backup copy of
UNTITLED.

Lines, Line of Text, Text

These terms are used to refer to alpha text using fonts as well as graphic files.
Graphics are treated as fonts having only one character. This allows strings of
words and whole graphics (pictures) to be manipulated in similar ways including
setting the height, width, rotation, mirror image, color, etc. Bursting a graphic
creates multiple text lines, one for each closed outline piece so that graphic parts
can be individually manipulated for color, production, nesting, etc.

Default Parameters and Default Environment

Default Parameters affect the first line in a new sign (font, height, X/Y position,
justification, etc.), the drawing size of a new sign and the system units (inch or
centimeter). These values can be changed if the status bar shows “Default
Settings”. in this mode, any changes made in the Edit and View menus will be
autornatically saved as new file defauits.

Search and Wild Card Symbols
<*> is a wild card character for all remaining characters.
<7?> is one character wild card.
Example: Suppose the following files exist in a directory:
aGraph
bGraph
syGraph
MySign
Let us use different templates to search:
?Graph - will display 2 file names aGraph and bGraph, but not syGraph;
2G* or 7g* - will display all files with second letter G;
2y* - will display: syGraph and MySign;
2227277 - will display all file names with 6 characters, everything but syGraph;
* and *c are the same, the ¢ is ignored and all files will be displayed.

S R

Cursor Movement

This number sets the amount of incremental movement for the arrow keys and the
mouse. The current value is displayed in the top, right hand corner of the status
line. You can set any positive number. Keep in mind - the mouse can become
“jumpy” when this number is too big. Vice versa, if the number is too small, it may
need a lot of mouse or arrow key movements to see any reaction on the screen.

All editing values are rounded to this number and cannot be made smaller than one
increment.




Definitions

For example, if you are presently working with an incremental step of 1.00 and you
want o change the Height of a line of text, values like 1.5 or 0.8 are non-accessible
unless you decide to edit by typing the number.

Usually numbers between 1/100 and 1/10 of your sign dimensions are the best for
linear parameters (Height, Edit Length, X, Y position etc.) and 1.00 to 10.00 are
used for angular or per cent changes (Rotation Angle, Width % and so on). Of
course, it is up to you to decide the resolution that you need. See [PgUp)/[PgDn]in
Standard Editing Keys section.

Normal Text Proportions

The Between Space is adjusted to 12% of the Height, the Width aspect ratio is set
to 100%, and the Edit Length value is set accordingly to the original font design
(undistorted). The initial value of the space between letters is set to .025” when
engraving [ENG] fonts are selected with small values of height. To keep text from
appearing to have overlapped letters see [B] Between Space.

Changing Height in AUTO Mode always provides normal text proportions for the
Height. Type H and enter a value or use a corner text handle of the first handle set
to normalize an active line.

Input / Editing box

A text box that is displayed on the right of the status line. Whenever a Line
Parameter name is displayed to the box and the box is enabled, you can edit the
parameter value by keyboard.

Stencil-Art Color Palette

The Color Palette allows you to change the color of text lines or the background of
your sign. You have a choice of 24 colors. To select a color, choose [C] and then
one of the following:

e Type the number that is displayed on top of each colored section and press
[Enter];

e Double click the desired color;
e Click on a color area and press [Enter] or click over the “OK” button.

[ o




Menus Qverview

File From the File menu you may initiate new signs, open existing signs, merge two
sign files or delete files. You may also save your work, import graphics to the
graphic library, export your sign as a bitmap, .GNT or .EPS file, or exit the program.

Edit The Edit menu allows you to insert, delete, copy or duplicate a line. You can also
access the Text sub-menu to view or edit line parameters. You can Undo/Redo the
last change to the present line. The Edit menu has a Select Lines feature that
makes it easy to select specific lines for display or change the order of appearance
of the lines. A File Report of the line parameters may be printed from this sub-
menu. Various other reports are also available. Refer to the Select Lines Sub-
menu.

Most edit parameters can be accessed from the side menu bar. The Text sub-
menu displays parameters which most affect a single line of text. Edit parameters
can also be accessed with corresponding keystrokes with the Text sub-menu down
or up. Itis not necessary to pull down the Text sub-menu to access its features.
All edit features can be changed while viewing your text lines.

The Edit | Group features allow you to make changes to an individual line or a
group of lines. From this menu you can copy or step and repeat consecutive lines.
You can make global editing changes to nonconsecutive lines.

View The View menu allows you to display a grid system, switch between inches and
centimeters, change the status of the Wire Frame option, and adjust the
mouse/arrow keys. The Sign Layout sub-menu allows you to control parameters
that affect the size and scale factors of your sign.

Transform From the Transform menu you can rotate, italicize and mirror a line of text.
Alpha text can be placed around an arc with the radius parameter or more
sophisticated line distortions can be applied. Inline | Outline and Welding of a
single line will compensate for tool path and eliminate text overlap. Graphics can
be burst into shapes for individual piece handling (coloring, hiding, nesting). Lead
line relief can be set for stained glass and similar applications. The ICU feature
(Interactive Curve Utility) allows curve smoothing and saving of an edited graphic.
Existing jobs can be refitted using the Project Resize feature.

Output The Output menu allows both device configuration and actual output to plotters
and printers. Device Configuration parameters can be set and saved as
permanent. Modification of Panel Size, output orientation and plotter velocity may
be adjusted from the Output tab.
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LETTER-ART ALPHA KEYS

A | Rotation Angle [ Pivots text on an angle. Text can be rotated at any m@é’. For example: a value of 1._ 80
will turn text completely upside down and in the opposite direction of 0 degrees. TEhe
default value of this option is 0 degrees. This feature is used in conjunction with
Radius Arc 1o create arced text.

B | Between Space o Adjusts spacing between characters in text. B

Line Color Selects coldring of text or graphic.
D | Drawing Size Sets size of drawing area. T ]
" E | Edit Length Adjusts the cdited length of text or graphic.
| F | Font S Initiates the font selection process.
G | Grid Set distance between grid marks or chan ge system units to inches or centimeters.
H | Height Sets height of text or graphic.
1 Italic Angle Sets either text or graphic at a slant from -60 to 60 degrees. o

J | Justification Justification at the X, Y value as either left, center or right justified.

L | Lead Line Lead line width (the gap between pieces) set or re-set for stained glass window
graphic.

M | Mirror Reverses image on base line.

O | Output Forces the screen regeneration of all displayed lines.

P | Pen Number Pen numbers affect output to multi-pen plotters.

Q | Quick Redraw Forces the screen regeneration of the present line.

R | Radius of Arc Used in conjunction with Angle of Rotation, this will create arced text.

S | Shade Density o -Adjusts the shade density to display or print the graphic with solid (shaded) color . F=or
screen display set at 0.01; for a 300 dpi printer set at .003; for a 600 dpi printer set at_.
-001. To see lines in full color, select View | Wire Frame | OFF.,

T | Text B This button INITIATES a Letter-Art drawin g page. Once you type [T], you will be
prompted to insert text or graphics. Pressing [T] on an existin g line will pull down tl—e
Edit | Text menu.

\ | Insert Line Inserts line or graphic. To insert, you can also press the [\] key on the keyboard, or
press the [ESC] key.

i Undo Undoes last parameter change. One level of Undo is available. ]

V[ Mono or Variable Space Toggles between mono and variable spacing, "

Width % The default width of 100% presents the text as the font was designed. Set the width t—o
less than 100% for condensed text and to more than 100% for extended lettering.

~ | In/Outline Border Creates a fixed border either to the inside or outside of text or graphic.

& | Distortion Click on text/graphic; hit right mouse to apply selected distortion over reclangular are=a.

$ | Welding Welding is turned ON to remove overlapping text or graphics.

(| Character Angle Rotates the letters in a text line.

" | Capital Letters % Height | Scales 1st character of every word in a line of text.




File Menu

When you select Open, Save As, Merge or Delete commands from the File Menu, a
screen is displayed which contains the following common elements: File list, Drive list,
Directory list, File name field, Description field, a Cancel button and a button that is
labeled with the action that you want to perform (“Open” for Open, “Save” for Save As,
etc.). For the Delete command there are two additional elements, File Type list and
Save Default Paths. The Open command also has a check box to allow sign preview.

To activate an element for selection, click it with your mouse.

Using the Drive and Directory lists you can access a desired directory. The File list
automatically shows the contents of the selected directory. By using the keyboard arrow
keys or your mouse, you can scroll the list and highlight a particular file. The file name
and description will be shown in the File name field and Description field respectively.
Double clicking on a file will open the files line list. Selecting [Open] will go directly to
the graphic display.

FILE NAME field can be used to type the required file name or to search for a file.
When you search, you can use the wild card characters <*> and <?7>.

NOTE: IF YOU PRESS [R] ON THE KEYBOARD WHEN THE FILE LIST IS ACTIVE, A NOTEPAD
ICON POPS UP. CLICK ON THE ICON TO STORE THE LIST IN A .TXT DISK FILE. YOU MAY
- FIND THIS FEATURE USEFUL IF YOU CREATE PERSONAL DATABASES OF YOUR DIRECTORY
' CONTENTS. THE FILE CAN BE OPENED WITH ANY PROGRAM CAPABLE OF READING .TXT
FILES.

To .escape from the menu, click on CANCEL or press ESC on your keyboard.

New

Select New while in a sign file to close the current sign file and enter the DEFAULT
environment with an UNTITLED sign. New allows you to begin a new sign or change
the default values in the Edit Text and Sign Layout menus.

When Stencil-Art is first started, the program originates in an UNTITLED sign.
Accessing Edit Text or Sign Layout and changing parameters before Text is entered,
records the parameter changes as default settings.

Text must be accessed to initiate a new sign file.

Open

Open is used to recall an existing sign. When Open is selected, a window will appear
for you to choose which file to open. Sign names may contain up to 8 alphanumeric
characters with no punctuation or spaces. An existing file may be recalled by typing the
file name at the File name field or by selecting the file from the listing using your mouse
or keyboard.

If Open is selected while a sign file is active, you are given the choice to save or
abandon your current work.

Sign Preview is normally off. Files can be opened using a single or double click on the
file name in the list. Single click a file name and then click on Open to see the sign in
the full drawing screen. Lines of the file will be shown or hidden according to the
arrangement of the sign when it was last saved. Double click on a file name to see the
Lines list before opening. You can then select lines for display or escape if this is not
the file you want.




File Menu

When Sign Preview is checked and files are selected, a single mouse click or keyboard
arrow (Up/Dn) in the sign list wili initiate a miniature sign preview. Two highlights may
pop up. Hidden Lines and Line Problems describe irregular lines in your file. Turn Sign
Preview off or click on the “x” of the preview window to go to normal sign selection. You
can single click or arrow (Up/Dn) to preview other files. The DEL key is active in the

preview mode and DEL can be used to move files to the recycle bin.

Push [R] (for Report) on the keyboard and a Notepad icon appears. Click this icon to
create a list of the sign files in this folder. The file name of this listis SYMLIST.TXT in
the signs folder and can be opened and printed using Windows Notepad.

Save [Ctrl+S]

Save is used to record all new and edited lines to the drive and directory of the sign file.
It is a good idea to save your work periodically as a precautionary measure.

Save As

Save As allows you to save the current sign file with a new sign name. This results in
two files This feature is useful when making changes to a sign file and saving
intermediate changes as a second sign file.

Select Save As and the display list is presented for your sign name selection. You can
save the file with a new name and create a new sign or choose an existing file. If you
choose an existing file, the original file information will be overwritten. Save As can also
be used to change the file description of an existing sign file.

Merge

Merge allows you to combine signs. The initial drawing size of the first sign is the
drawing size of the new merged one. You may start from an existing or UNTITLED sign
and Merge will add all lines of a chosen sign. The Merge function does not permanently
affect any existing sign files unless you choose Save or Save As from the File menu.

Delete/Set Path

Delete allows you to choose files from a designated directory for deletion. The Delete
command sends files to the Windows Recycle Bin. You may delete sign files (.SYM),
imported graphic files ((GNT), CAD files (.DXF), plot files (.PLT), encapsulated
postscript files ((EPS) or raster files (.PCX). The FILE TYPE list, displayed under
Directory list, allows you to change the TYPE of file for deletion. Select the appropriate
file type from the listing. All files of this format will be listed. You may delete files of any
file format used in Stencil-Art. To choose a file for deletion, use your keyboard arrows
or mouse to scroll through the list. Hit [Enter] or click the Delete button to delete the file.
When a file is chosen for deletion, the screen prompts for verification. If you enter [Y]
Yes, the file is deleted and the listing is re-sequenced. Selecting [N] No returns you to
the prompt for a file to delete.

Push [R] (for Report) on the keyboard and a Notepad icon appears. Click this icon to
create a list of the sign files in this folder. The file name of this list is xxxLIST.TXT in the
current folder, where “xxx” is the current file extension. The file can be opened and
printed using Windows Notepad.

Selecting the Save Paths button records the last known Drive and Directory (Folder)
path of each of the different file types. Organizing graphics, signs, scanned images,
elc. into separate folders helps improve program response time and also isolates files
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File Menu

which will need to be periodically backed up. The saved paths are used as defaults to
start new signs.

Import

The Import Files option allows you to bring files into Stencil-Art produced in other
programs in Drawing Exchange Format (.DXF), HPGL plot file format (.PLT), and
encapsulated postscript format (.EPS, .Al). Refer to Import Files for details.

Export
The Export option allows you to create a bitmap (.BMP or .PCX) file from your sign.

Paint BMP files - Export will save the BMP file in the main Stencil-Art folder. 1t will
also open the export file with the default Windows application for BMP files, usually
Windows Paint. Depending on the status of the Wire Frame option (View menu) you
will have a shaded image or outlines only. If you want to save this graphic you can
rename (Save As) from Paint. Any software that reads .BMP format can work with
your graphic.

Adobe PCX files - Exporting a PCX file is a key feature of Stencil-Art in working
with the scanning program Adobe Streamiline.

s The exported .PCX file is a compound of the displayed text and graphics of your
sign, so that upper layers erase the conflicting areas below. The Line Order is
significant for the result. Line # 1 is the bottom layer, when shown.

= The exported .PCX file is 20 x 20 inches with 300 dpi resolution. You can save
the file or spawn Adobe Streamline in which case the file SGIMAP.PCX will be
written and the Adobe program initiated.

Adobe EPS files - Exported EPS files may be used with other programs such as
CorelDRAW and Adobe lllustrator. The option to eliminate double line information
during export makes it a unique tool.

NOTE: STENCIL-ART USES ADOBE ILLUSTRATOR 3 CONVENTION FORMAT TO WRITE A
WIDELY ACCEPTED .EPS FILE.

Stencil-Art GNT files - Export .GNT is a feature designed to skip an extra step
present in previous versions. It combines File Export and File Import to speed up
GNT creation. This is a quick way to combine text and graphics for logo designs. It
enables you to permanently group text lines and also gives you the ability to convert
old .GNT files to the new type .GNT files. The new file format allows graphic
bursting so that individual pieces can be spot colored and graphics can be cut by
color layers. Bring up the file in Stencil-Art, export it with the same name GNT.

NOTE: IF THE ORIGINAL FILES USED TO MAKE THE .GNT GRAPHICS DID NOT HAVE CLOSED
PIECES, EXPORTING CANNOT FORCE THE PIECE CLOSURE REQUIRED FOR GRAPHIC
BURST TO WORK CORRECTLY.

Export .GNT works only with the active lines, which gives you a way to isolate and
save different portions of an existing graphic into a new file. You will have to burst
the master graphic (permanent or bridged .GNT file), hide / delete all unwanted
pieces and export as Stencil-Art .GNT file. This technique lets you eliminate noise
in a file, combine different graphics or combine text and graphics.

During output you are provided with information about the new graphic Height and
X, Y location in the present sign.
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Exit

Exit allows you to exit Stencil-Art. If a sign is in progress, Stencil-Art asks if you want to
save the sign for future use. Choose [Y] to save any changes made to the sign file.
Select [N] to ignore all changes made to the sign and to retain the previous version.

Import Files

The import process automatically converts the imported file into a Stencil-Art graphic file
(.GNT) which can then be used as a line of text in a sign file.

NOTE: ENCAPSULATED POSTSCRIPT (.EPS) FILES MUST CONTAIN WIRE FRAME VECTOR
FORMAT INFORMATION. THE IMPORT PROCEDURE DOES NOT ACCEPT .EPS FROM A
SCANNER. SOFTWARE PACKAGES SUCH AS COREL DRAW CAN EXPORT AN
ENCAPSULATED POSTSCRIPT FORMAT COMPATIBLE WITH STENCIL-ART.

Select [I] Import from the File menu to access the Import display screen. This window
consists of the features described below:

# Type - This entry displays a list of file types which can be imported from outside
resources such as Corel Draw and Auto CAD. Importing a file to Stencil-Art is a process
of saving the vector outline and packing the saved data into a .GNT file for Stencil-Art
use. Select the .DXF, .PLT or .EPS/.Al file type from the list.

Once the file type is established, the PATH can be selected. The Drive List and
Directory List show you the current path and allow you to list and select directories other
than the Stencil-Art directory. To change the path, access the Drive or Directory List
with your TAB key or click inside of the list with your mouse. Then scroll through the
drives and directories respectively with your mouse or keyboard arrow keys. A drive or
folder is not selected if it is only highlighted. Double click it or press [Enter] to
make it active.

When the file type and path are established, all files of the selected type in the selected
directory are listed in the file window. To select a file for import, activate the file window
with your TAB key or mouse. Use your keyboard arrow keys or mouse to locate and
select a file name. Double click a file name if you want to view the graphic. if you wish
to delete the previewed file, press the [DEL] key on the keyboard to remove it. To save
a selected file press the “Save” button or [Enter]. Stencil-Art lists your default graphic
(.GNT) directory. Use the Drive and Directory List to adjust the path for saving. Inthe
“Name’ field, type a file name of up to 8 characters (the original file name is shown and
can be used). A file description of up to 24 characters can be entered for later
reference. If you select or enter a file name that already exists, you will be prompted to
confirm the overwriting of the file.

The file name entered (or the default name accepted) is used to name the .GNT file. A
.GNT file is a Stencil-Art graphic file. All imported files or Raster/Vector conversions
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File Menu - Import Files

result in a .GNT file for use in Stencil-Art. The .GNT file is added to the .GNT graphic
file library. The last path (drive and directory) set for graphic files in Text or Delete
becomes the default directory for .GNT files.

When importing a DXF file, Stencil-Art will ask if the Separate pieces filter is desired. If
you choose “Yes”, the filter will find and connect random segments into ordered closed
shapes such as for stained glass. The common boundary of side by side shapes will be
associated with each piece so pieces can be selected for color ayers. For example, if
the “Sticky Foot” feature of Glass-Eye has been on during file creation, using the
Separate Pieces import filter will make the graphic ready for bursting and coloring in a
matter of seconds.

To use a graphic in a sign file, the graphic file (FILENAME.GNT) is used as a line of
text. Select T Text and F4 to list and select graphic .GNT files while in a sign file. You
can use the same graphic file in one or more sign files.

A GNT file may be manipulated using Height, Edit Length, Rotation, Angle,
Inline/Outline, Graphic Burst and most other editing features.

Because clipart collections can have hundreds of files, it may be useful to set up
different .GNT directories such as LOGOS, AUTO, and one or two categories LAGNT1
and LAGNT2. When you add new collections to your system or make new .GNT files,
save them in the appropriate directory for later use.

Stencil-Art saves the path where the .GNT file was located when the sign was last
edited. Use of multiple .GNT files and the respective directories are allowed. Moving or
renaming files or directories should only be done with the understanding that the
affected signs may need to be re-edited.

Older versions of Stencil-Art limited graphics to 220 pieces. That limitation has been
expanded to 2500 pieces. To bring an old graphic up to the new standard you have to
export the graphic as an .EPS file and re-import it. See the Graphic Burst Transform
function.
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Undo / Redo

Undo allows you to cancel the last parameter change. This is a single level function.
Redo will bring a parameter change back if you decide not to cancel.

Text

The Text sub-menu displays most of the parameters which affect a single line of text.
The Text parameters can be accessed with the corresponding keystroke from the Edit
Text menu or from the side menu bar with the mouse. It is not necessary to pull down
the Edit Text menu to access its features. All edit features can be used while viewing
your text lines. XY placement can be adjusted by dragging and dropping the line to a
desired position. The Height, Edit Length, Italic Angle, Rotation Angle, Between Space
and Width can be accessed with a mouse using the text handle which controls that
feature. See Line Parameters.

The Edit Text parameter values can be changed and recorded as default values for
opening new sign files. To do this, the sign name must be UNTITLED and the status
line must state “Default Settings”.

Insert Line [\]

Insert allows you to insert or add lines to a sign. To add a new line at the end of a sign,
select [ \ ] from the Edit menu and enter a number larger than the Iast line in your sign
(i.e. 99).

You can also add a new line between lines of text by entering a line number which
already exists. The new line will be inserted before the line number entered.

Insert presents an empty Text box on the screen for entry. When a line is inserted, it
assumes the characteristics of its preceding line, except for any Inline/Outline or
Distortion values. The new line X,Y position is below the previous text line by the value
in = Line Space. The X,Y position of the new line will be positive or zero to remain
inside the drawing size.

NOTE: FOR USERS WHO PREFER THE NEW LINE DOWN FEATURE TO DETERMINE THE
AMOUNT OF SPACE BETWEEN LINES, SET = LINE SPACE TO 0. THIS WILL ALLOW YOU TO
ENTER A LINE OF TEXT AND PRESS N NEW LINE DOWN FOR PLACEMENT.

After entering text and adjusting applicable parameters, pressing [Esc] or [ \ ] allows you
to continue inserting new lines.

Delete Line [Del]

Deilete line removes the active line of text and the remaining lines are re-sequenced and
redrawn. You can access this feature by simply pressing the [Del] key when no menu
is pulled down. The Edit | Group | Delete feature is useful for multiple line deletions. In
the Group mode, the selected group will be deleted with the [Del] key.

Copy Line [CTRL + C]

Copy creates a new line with identical characteristics to the original line. The new line
will be superimposed. For multiple copies and/or a X,Y transposition of the new line from
the active line, use [Ctrl + V] Duplicate Line. In group mode Copy Line activates the
Copy Transposition screen.
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Duplicate Line [CTRL + V]

Duplicate activates the Copy Transposition screen to create new lines with identical
parameters of a selected line. You can set the number of copies and the X,Y Copy
Transposition. All new lines will have identical characteristics to the original line and will
be superimposed by default, i. e. Xand Y are zero. If the X, Y values are not zero, the
copies will be displaced from each other by X, Y.

The Copy Transposition screen shows 4 buttons, painted with the following icons:

R e

The red box represents the original positioning. Use these buttons to define the
direction of offset reproduction.

The X Transposition and Y Transposition fields show the physical distance horizontally
and vertically from one repetition to the next. By default these values are 0 so the
original and all copies will overlay. The Copies field determines how many repetitions
will be made. In group mode Duplicate activates the Step & Repeat group feature.. See
also Edit | Group | Copy Transpose and Step & Repeat.

Select Lines [Ctri+L]

This feature allows you to change the line or range of lines displayed on the screen.
Select Lines is an easy way to change the lines being displayed or modify the line order.
From the Select Lines window you can also print a report of the parameters of each
selected line of text to use for shop instructions or fo file with customer information. Any
combination of lines may be selected or hidden (deselected). Lines.can be selected by
number and/or color for display and production.

Group

This feature allows you to make changes to a group of text lines. From this menu you
can select lines from the line list and then move, copy, repeat, rotate, hide or delete
lines. You can also make global editing changes for a group of lines. Lines are
highlighted when presently selected in a group.

Ungroup

Ungroup will release the group mode. Clicking with the left mouse button inside the
drawing area away from the rectangular area that contains the group ore outside of the
drawing area will also ungroup the present line selection.




Edit Menu - Select Lines

Select Lines Sub-Menu

The Select Lines sub-menu helps you to list, review and reorder all of the text lines with
their corresponding parameters. You can display or hide lines and you can also print a
report of the selected lines. You can display or hide lines during File | Open or when a
sign is in progress. Various reports are available if the sub-menu is accessed from the
Edit menu.

Line List is a chart with first column Color, second - Line #, third - a cross x , that
shows the status of the line - displayed or hidden, the fourth column is the text of
the line. When the menu is down, these 4 columns are permanently exposed and
the rest of the chart is a scrollable area where all parameters that describe a single
line of text are listed.

Off, On or Toggle - You can click over any of these options. It is active if the circle to
the left is filled. Only one action is possible at a time.

Select All - Selects all lines as visible. Use this butfon as a first step if most of your
lines are active. Select Off action after this and point to the lines you want to hide.

Clear All - Makes all lines hidden. Use this button as a first action if most of your lines
~are hidden. Select On and then point to the lines that you want to display.

Liné Select menu enables you to type line numbers that you want to change according
" to the action (Off, On or Toggle) that is selected. You can have the same result if
" you drag with your mouse over the second or the third column from the first to the
" Jast desired line.

Color Select menu will display the Color palette where you can choose a color to be
On, Off or Toggled. This action affects all the lines with this color. You can have
the same result if you click with your mouse over the desired color box from the first
column. This technique can be very useful to select lines for editing or production
by color.

NOTE: TO CHANGE A SINGLE LINE OF TEXT, SELECT AN ACTION WITH YOUR MOUSE AND
CLICK ON THE SECOND OR THIRD COLUMN OF THE CHART AT THE CHOSEN LINE.

Undo - Restores the selection before the last action including Select All and Clear All.

Save Selection and Back to Saved buttons work together. They are useful when you
have a complicated sign. “Save Selection” will store the last selection. “Back to
saved” will help you restore the saved selection before changes were made.
“Undo” will take you back one change at a time.

Reports - Choosing this option will bring up a menu on the screen, showing reports
available at the time.

Line Parameters Printout will print all currently selected lines with their
specifications. The Printed report contains the individual line comments which may

be useful for installation, shop or material instructions. This report can be used as
a hard copy of the job setup, for customer files and future reference.

Screen Reports - Available only when a sign is in progress. You can access these

reports from the Reports pop-up menu or by pressing respectively [F2], [F3] or [F4]
keys on the keyboard.
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<F2> Separated pieces report - Shows total of rectangles surrounding individual
pieces. The report does not compensate for overlapping pieces (lines) or the
distance between them. This report can be used in calculating the cost of a sign
(all waste material is disregarded). The report also can be viewed as the optimum
material usage without overlapping line areas. The line areas are always
rectangular horizontal boxes. If the job allows line/piece rotation for nested cutting
you will probably be able to conserve even more material.

<F3> Combined pieces report - Shows rectangular area of material needed to
contain all displayed lines as they are placed whether in their original positions or
nested. The Height and the Width of this area have several applications. Refer to
this report whenever you need to measure areas for Group Repeat, Copy
Transposition, nested pieces of colored layers or for graphic size coming back from
compounded lines via Streamline or plot files (.PLT).

<F4> Cutting report - This report calculates four parameters.

Pieces: Represents the number of separate shapes or pieces selected for display.
For graphic files (imported by Version 9 of Stencil-Art) this count is the number of
pieces from a graphic burst. For text there will be a piece for each letter part. In
the letter “B” in most fonts, there will be 3 shapes - one outline and two holes. If
you do not have a sequential input file where vector parts are well organized, the
number of pieces will exceed your expectations. Files edited by CAD programs
often fragment the outline segment sequence. Many disconnected pieces will be
counted even though they appear to form fewer objects.

Perimeter: The total distance of tool down (cutting) travel in inches.
Travel: The total distance of tool up travel without cutting in inches.
Leading is the total of selected pieces’ perimeters in feet.

NOTE: THE REPORTS ARE NOT AUTOMATICALLY UPDATED WHEN THE LINES SELECTION IS
CHANGED. PRESS THE APPROPRIATE KEY STROKE TO GET THE NEW REPORT.

Reorder by color - Re-sequences all lines in the order of the colors from the Stencil-
Art Color Palette.

Reorder from... to... - This option changes the position of a single line of text within
the listing of all lines. It will also affect other lines. For example, if you change line
2 to be line 5, lines 3,4,5 will become 2,3,4 respectively. Vise versa if the fifth line
of text is moved to second place, lines 2,3,4 will become 3,4,5 respectively.

Selecting this menu will change the bottom panel of the active screen. Two input
fields are shown “Move Line #' and “to line #”. The first one represents a line by its
number from the Line List. The second one will be the desired new line position.

Reorder button - Press or click this button to effect the order change. This will
update the Line List and you will be able to continue reordering, finish or abandon
the changes.

Done and Abandon - Are the buttons to take you from the Reordering mode back
to selecting lines, accepting or abandoning changes respectively.

OK button - use this button for confirmation of changes.

Cancel button will hide this menu and ignore all of the changes that you made.
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Group Operations

Global changes to multiple lines may be made either by accessing the Edit | Group sub
menu or by selecting multiple lines with the mouse.

Group Select with the mouse - There are two ways to select a group of lines with the
mouse. Only lines that are in the present view can be selected.

1. The first method is to select a group by dragging the mouse around the lines of
interest. A rectangle will be drawn with one corner fixed at the point where the dragging
was initiated and ending at the opposite diagonal corner. The mouse button should be
released to finish the selection process.

NOTE: ONLY LINES THAT ARE ENTIRELY IN THE BOX WILL BE SELECTED.

NOTE: GROUP SELECTING BY DRAGGING SHOULD BE INITIATED OUTSIDE THE LIMITS OF
THE PRESENT ACTIVE LINE IN ORDER TO AVOID DRAGGING/MOVING THE LINE ITSELF.

2. By holding the shift key down and clicking with the mouse over a line, the line can be
toggled in or out of the group. Lines can be added to (or subtracted from) the group by
holding down the shift key and clicking on the line.

'NOTE: TO SELECT A LINE FOR THE GROUP, CLICK NEAR THE PERIMETER.

One can also select the Edit | Group | Edit menu to fine-tune the group or select lines
that are hidden or out of view. A “Group Mode” text will be shown under the menu bar to
indicate that a group is active.

The:Group Mode is terminated by left clicking outside the design area or outside the
active group rectangular area. Selecting the Edit | Group | Ungroup menu will also
terminate the Group Mode.

The Group Move and Edit menus operate very similar to Select Lines, but will move or
edit both visible and hidden lines.

Move Group - Moves the X,Y positions of a group of lines by a specified amount which
may be positive or negative. The positive or negative delta values entered are
added to the present X,Y values so that all relative positions are maintained.

Group Dragging - Once a group is selected it can be dragged to a different location on
the screen the same way a single line can be dragged. Position the mouse
anywhere in the group. Push the left mouse button down, drag the rectangle to its
new position, and release the mouse. The «X,Y» numbers, displayed on the top
right of the screen, are the X and Y distance changes for all members of the group.

Group Moving with the arrow keys — A group can also be moved by using the arrow
keys. As with group dragging, a limit rectangle will show the new positioning. The
«X,Y» numbers, displayed on the top right of the screen, are the X and Y distance
changes for all members of the group. When the desired position is reached, press
the [Enter] key to confirm the change.

NOTE: POSITION CHANGES INVOLVING THE MOUSE OR ARROW KEYS ARE AFFECTED BY
THE CURSOR MOVEMENT VALUE.

Edit Group - Edit Group is an efficient way to make mass changes to any number of

lines. All of the Line parameters are available for group editing. Each line will be
changed according to its own features.
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For example: You could change the Font of a group of lines. If there is a graphic
(.GNT) line in the group, this line will be skipped and will remain unmodified. If you
want to change the Height of all lines, the graphic lines will be affected.

Changes to the group are made by selecting the keystroke or side menu button
followed by typing appropriate values for the parameter. The default values shown
in the editing box are the value for the last active line of text.

Delete - This feature allows you to delete many lines at once. If all lines are deleted a

new UNTITLED sign will be invoked.

For Group Step & Repeat operations you must specify sequential lines. For example
lines 5,8 means all lines of text including 5 through 8. See “Reorder Lines.”. If the lines
that you need to copy are not sequential, you must establish the group before selecting
Copy Transpose or Step & Repeat menu.

Copy Transpose - In the Copy Transposition menu, you will be able to copy a line

(group) and adjust the relative position of copies. If no group is selected, Stencil-
Art will use the current active line.

Step & Repeat - This feature is used for making multiple row and/or column copies of a

group of lines. Select Step & Repeat from the Edit | Group sub-menu. If no group
is selected, Stencil-Art will prompt you to define a group of sequential lines of text
by typing the first and the last line #. -

When you choose the group of lines to be repeated, a sub-menu appears. On top

of this window you will see 4 buttons:
By
-0 Oja-0

The red box represents the original group position area. The blue boxes show the
repeat positions. Use these buttons to define the direction of offset reproduction.

L]
00

The Width and Height fields show the dimensions of the rectangular area required
by the group. Increase these values if you want margins. Decrease them for
overlap. If the values remain as they appear, the groups will touch. The Width and
Height values are used as the physical distance from one repetition to the next.
The column and row count determine how many repetitions will be made
horizontally and vertically.

Group Rotate - Group Rotate feature rotates a group of fines around a common center
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of rotation. The Angle parameters of the lines may not have the same values after
Group Rotate, it will depend on the angles of the individual lines included in the
selection.

After the Group Rotate menu is selected, the Select Lines screen comes up. The
line selection can be changed, if necessary. After the selection is confirmed,
another screen comes up to assist the choice of Rotation Angle and Center of
Rotation.

Center of Rotation. There are 8 different positions over the group limits to choose
from — the 4 corners of the group limit box and the 4 middle points on the sides of
the group limit box. There is a ninth position available, which represents the
geometrical center of the group limit box.

This last position is set as default because it gives the best odds for keeping all
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lines inside of the drawing area after finishing the rotation. It is also easy fo undo
such rotation, if needed. Rotating the group on the same angle, but in opposite
direction will return all lines into the previous places.

Angle of Rotation. A number between 0 and 360 can be typed. One can also use a
“* sign to indicate clockwise rotation, and a “+” sign (or omit the sign) to indicate
counter clock rotation (see the interactive diagram under the input field).

NOTE: ON A LINE THAT HAS A DISTORTION SET, ANY CHANGE OF THE ANGLE PARAMETER
AFFECTS THE OUTCOME OF THE DISTORTION. ROTATION AND CHARACTER ANGLE
PARAMETERS SHOULD BE SET PRIOR TO DISTORTION. WHEN THIS IS NOT POSSIBLE, THE

DISTORTED LINE SHOULD BE EXPORTED AS A GRAPHIC .GNT AND THE .GNT SHOULD
REPLACE THE LINE BEFORE ROTATION.

Group Hiding - A group can be hidden by selecting "Hide Line [Ctrl + H]" from the Hot
Key List on the side menu. Group Mode has to be established by either selecting

lines from the Edit |Group | Edit menu, mouse selection, or a combination of the two
methods. Press [Ctrl + H] to hide the group.

Group Hide terminates Group Mode and returns to single fine mode.
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Zoocm

Zoom enables you to change the viewing area of your sign. There are three available
options: Zoom In establishes a more detailed view; Zoom Out returns you to the
previous zoom level; Normal View returns the normal view of your sign. For details see
Zoom Options.

Wire Frame

Wire Frame turns On or Off the shading on the screen during editing. It also affects the
Export .BMP function from the File menu. To have shaded output to a plotter or printer,
you must select the Shading option from the Output menu.

Grid / System Units

Setting a grid gives you a visual reference of the placement, size, and scale of your
sign. The “Step” field shows the distance in inches or centimeters between Grid marks.
Enter a positive number to change it. Toggle Show Grid box to hide or display the grid.
The Grid sub-menu also allows you to choose a unit of measurement (Inch or
Centimeter). This will affect all sign measurements. Be sure you are using the right
units before you output.

In the DEFAULT environment, the unit of measurement will be stored as permanent.

Cursor NMovement

This parameter sets the incremental value for your arrow keys and mouse when editing
a line of text.

Sign Layout

The Sign Layout sub-menu allows you to control parameters which affect the
dimensions and appearance of your sign. You may set up your sign dimensions or
scale your sign to fit a certain area. The Sign Layout sub-menu can be accessed by
typing D on the keyboard or clicking on the “D” button from the side menu. In the
DEFAULT environment, the sign dimensions will be stored as permanent.

Background Color

This feature allows you to change the Background color of your sign on the screen.
When this color conflicts with a line Color parameter, you will be prompted to change
either the Background color or the line Color. You can ignore this question, but, you will
be asked again every time the sign is redrawn. To save time, do not use this method to
hide lines, go to Select Lines (Edit menu) and change the displayed group of lines. lItis
usually better to select a background color that is not also used in the sign.
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Zoom Options

The Zoom functions can be accessed using any of the following three methods:
= from the View menu;
= by typing Z with no menu pulled down and using the keyboard arrow keys:
m using only your right mouse button.

Zoom In option - To seta Zoom In means to establish a rectangular area of your sign
that you want to see in more detail.

By mouse: Move your mouse to one of the corners of the imaginary zoom window.
Press your right mouse button and drag toward the diagonally opposite corner of the
same imaginary area. A red rectangle appears. As you can see, it is with one
corner stacked to the starting point and the opposite corner is connected to your
mouse. Release the right mouse button when the red rectangle surrounds the
desired area.

By keyboard: Press Z on your keyboard to begin. A red rectangle rims your sign.
The starting point of the Zoom window must first be established. Use the arrow keys
(one increment at a time) to move the rectangle so that one of its corners reaches
the desired starting point. Press [Enter]. Use the arrow keys again to establish the
width and the height of an area to be zoomed and press [Enter].

From the menu: Select Zoom In from Zoom sub-menu of View menu. A red
rectangle rims your sign. To establish the zoom window foliow the keyboard
instructions above.
The Zoom window may be positioned to encompass any or all portions of your sign.
Opposite corners of a Zoom window may be selected in any order.

The window can be moved 25% of its present size at a time or to the limits of the sign by
clicking the panning arrow buttons invoked by the Zoom In function (look at the lower left
corner of the main screen). The panning arrows only appear when zooming is
presenting a fractional portion of your sign. These buttons will disappear when you are
back to a 100% view.

When Zoom is more than 100%, the four arrows on the outer edge of the display screen
allow you to pan or move the viewing area with your mouse while retaining the Zoom
factor. The keyboard can also be used to pan when zoomed. The keyboard keys used
are Home=Left, End=Right, Ctrl-PgUp=Up, Ctrl-PgDn=Down.

Zoom Out option - This feature will return the viewing area of your sign to the
previously established Zoom window.

By mouse: Double click with your right mouse button inside the displayed portion of
your sign.

By keyboard: Press [Ctrl + Z].

From the menu: Select Zoom Out from Zoom sub-menu of View menu.

Normal View option - Selecting Z and pressing [Esc] will reset Zoom to the full (100%)
Drawing Size dimensions.
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Sign Layout Sub-menu

Sign Width and Height - The Sign Width and Height values determine the drawing size
display of your sign. These parameters have no limits and can be larger than the
physical plotting limits of your plotter. If the drawing size exceeds the configured
Panel Size of your plotter, your drawing will be output in a series of Panels. The
Drawing Size may be different for each sign and is retained with each sign file. The
Drawing Size within a sign controls its display when recalled.

NOTE: ANY PORTION OF TEXT OUTSIDE THE DRAWING SIZE OF THE SIGN CANNOT BE
OUTPUT.

Scale Factor - This entry increases or reduces your drawing by a percentage of the
Drawing Size. A Scale Factor of 100 means your sign will be output at 100% of its
original size. A factor of 50% reduces the sign to half of the designed layout. The
drawing may be scaled proportionally by entering the same scale factor for X and Y
or scaled differently in the width and height directions by entering different values
for X and Y scaling.

The line parameter values shown on your screen will not change, but the actual
size of the display and to the output device will reflect the scaling change.
Enlargement may require that you increase your Drawing Size to incorporate the
full graphic image.

NOTE: SCALE YOUR SIGN BEFORE EXPORTING AS A BITMAP. FOR BEST RESULTS, AVOID
SCALING IN THE RECEIVING PROGRAM.

Once new values are entered for Scale Factor, they remain set until changed again,
or a different sign is accessed, or until you exit Stencil-Art. Scale Factor can also
be changed in the Output menu if your sign needs adjusting before output. Scale
Factor is NOT retained as part of your sign file. See “Transform | Project Resize”
for further discussion.
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Transform Menu

This menu allows you to Rotate, Italicize, Mirror, Curve, Distort, Lead Line,
inline/Outline, or Weld text (see Line Parameters section in the Users Guide.)
Graphic Burst, Project Resize and Interactive Curve Utility (ICU) are also initiated here.

Graphic Burst - This feature applies only to graphic images (permanently imported or
temporarily bridged). The image is ungrouped so that each piece becomes a
separated line to be individually edited and spot colored. Color layer selection can
then be used in production. (Also see Spot Color and Color Layer Separation in the
technical notes about Adobe Streamline). This function can also be used to gain
information about the piece count in a graphic.

If selecting the Graphic Burst function produces no action, you have a graphic that
cannot be burst. The reason for this may be:

1. The line is a regular Stencil-Art text line (with an associated font);
2. The graphic has only one piece;

3. The graphic was imported to Stencil-Art program Version 8 or earlier. (See File
| Export | Adobe .EPS for possible file upgrading.)

NOTE: IF THERE ARE MORE THAN 2500 PIECES, THE LAST PIECE WILL CONTAIN THE
OUTLINES OF ALL REMAINING UNBURST SHAPES.

When an image is burst, you can refer to the Edit | Select Lines menu to see the
result. The burst graphic file name appears in every newly created line. The first
and last lines of a burst graphic have no number in front of the file name and will
not be actively selected by default. All other lines will have a piece number in front
of the graphic file name. The piece: numbers correspond to numbers that will
appear in color separations and printed enumerated maps.

The color code of the first and last lines will be given a gray color to isolate them
when using color for line selection.

The last line of a burst graphic file is a repeat of the first line. These two lines will
have their Shade Density set to zero and neither will be actively selected by default.
When shading is turned on or when the Wire Frame | Off is selected, these lines
will not shade. Selecting either line will show all parts as a single entity.

NOTE: IF THERE ARE GRAPHIC PARTS THAT DO NOT SHADE, IT MEANS THAT THEY ARE
OPEN SHAPE PIECES OR THAT THE VECTOR PARTS ARE NOT CONTIGUOUS IN THE
GRAPHIC FILE. PROGRAMS USED TO EDIT GRAPHICS MAY OR MAY NOT HAVE A FILTER
THAT RECONNECTS GRAPHIC OUTLINES, THUS, VECTOR PARTS WHICH SHOULD BE
CONSECUTIVE MAY BE IN SOME RANDOM ORDER. REFER TO YOUR GRAPHIC EDITING
SOFTWARE EXPORT FEATURES. '

Interactive Curve Utility (ICU) Mode — The Interactive Curve Utility edits graphics by
smoothing curve transitions in a vector path. Parts can also be deleted and the
graphic can be saved in a .GNT or .EPS format. The mode is initiated from the
Transform menu when you have a single graphic line in a sign. This will change
the top menu bar on your screen. The ICU Mode menu can be accessed from the
revised top menu bar, or from the side menu Hot Key button, or by selecting [Shift
+ right mouse click] inside of the drawing area.
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Curve Smoothing — The raster to vector conversion in Adobe Streamline, as
powerful as it is, may leave small imperfections in the curve to curve transitions.
The Curve Smoothing Ultility is designed to help you smooth these problem areas.

Raster/Vector conversion with Center Line + Separate Shapes options, generates
vector outlines that are doubled between neighboring pieces. The Interactive
Curve Utility smooths intersections and applies changes to the paths of all affected
pieces. This unique feature makes editing of such graphics easy and accurate.

After the ICU Mode is initiated the graphic is redrawn in gray and the first path
becomes active. The active path is always drawn in green with orange nodes
marking the curve transitions that can be smoothed. When you select a piece that
does not have any curve information a message comes up

No curves in this segment. Nothing to edit.

Pieces in ICU mode are selected similar to the way lines are selected in the design
mode. HOWEVER, hold the [Ctrl] key down when clicking inside of a piece.
Pieces will turn green when selected. If the active piece has no problem areas, no
orange nodes will be displayed. If an orange node should be smoothed, click on it
and it will smooth. Sometimes a node will need smoothing more than once.

The Lock Piece menu option: If Lock Piece is not selected, clicking on a different
piece will activate that piece for node editing. If selecting a node causes a different
piece to be selected, use the Lock Piece menu option. When Lock Piece is on, line
selection is available only with [Ctrl + left mouse click].

When all the shown nodes in a piece need to be smoothed you can select the
Smooth Piece function [Ctrl+P]. However, the order of selecting nodes is
significant. Smoothing a particular curve transition may affect the next or previous
curve transitions, resulting in fewer or more nodes to be displayed. Smooth Piece
using the automatic node order may not be the best solution in such cases.

To show all nodes that are left to smooth, select the Show All Points menu option.
This is the most time consuming feature and it should be used sparingly. Use this
option only to see the progress being made during editing.

Deleting Pieces — Selecting the Delete Piece option from the ICU mode menu or
pressing [Del] on the keyboard will result in deleting the active path from the
graphic. This will modify the graphic file. Here are a few tips on how to use the
Delete feature in the ICU mode:

- If your goal is to isolate graphic parts into a new graphic, delete all
unnecessary pieces and re-save the graphic under a new name.

- If there is residual noise from bad scanning and/or conversion you can
delete all of the noise paths and re-save the graphic.

NOTE: DELETING PIECES AFFECTS THE TOTAL NUMBER OF PIECES AS WELL AS THE
SEQUENTIAL NUMBERING OF PIECES WITHIN THE GRAPHIC. IF YOU ARE EDITING AN OLD
GRAPHIC THAT HAS BEEN INCLUDED IN OTHER JOB FILES, BE SURE TO USE A NEW FILE
NAME WHEN SAVING THE EDITED GRAPHIC FILE.

Undo — In the ICU Mode you have one level of undo. You can save changes as
you make them under different file names (i.e. Step1.GNT, Step2. GNT) which can
be useful for more complex jobs.
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Project Resize — The Project Resize menu is accessible through the Transform menu.
Typically, text and graphics are not intermixed when using the Project Resize because
the special adjustments that apply to graphics do not apply to lines of text. There are
also differences in the Project Resize feature, depending on whether single line or group
mode is used.

Single Line mode. A single graphic piece line should be selected. All pieces related to
the same graphic name will be automatically found and processed. Unlike scaling, each
piece is resized and the X,Y coordinates are changed to accommodate the new pieces.

When activated, the Project Resize menu displays the present Height and Width of the
original graphic in the Sign Size column. The Scale column shows the percentage
change of the original size.

There is a check box to control whether the resize changes are proportional. The
default status of the box is checked and any change to the Width values will
automatically make proportional changes to the Width values and visa versa. If a
disproportional change is needed, the check box should be cleared. Note: Intermixed
text and graphics must be resized proportionately.

One can change the project size by giving new Height and Width values in either
inch/cm dimensions or as a percentage of the original size.

Project Resize affects all lines that have the same graphic name as the present active
line; whether hidden or displayed. Project Resize works best for proportional changes
of the graphic Height and Width. Disproportional changes work well for up to 10%
difference in the Scale column. If one has a too close fit between the pieces and
disproportional resizing is needed, a check for piece intersection will be necessary after
the automatic resize is done.

NOTE: The Project Resize feature quickly resizes jobs containing nested graphic
pieces. If all pieces are in their original place within the master graphic, a better way to
resize is to group all pieces and give them a new Height and/or Edit Length. If the job is
a combination of nested pieces and a master pattern, first apply the Project Resize and
then group the master pattern and set the same X and Y coordinates to all members of
the group. See "Group Select with the mouse” in the Group Operations section.

Group Mode. Project Resize affects only selected lines.
The “Keep Proportions” box is always checked and Project Resize proportionally resizes
the group.

The Group Mode Project Resize would give an excellent first draft for reusing existing
signs for a different job. It proportionally resizes all text lines by changing Height, Edit
Length and Between Space parameters in order to keep the proportional appearance in
the sign.
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Distortions Sub-Menu

The Distortion feature allows you to apply over 60 predefined and thousands of custom
transformations to text and graphics. Preset Distortions include waves, arcs, peaks,
notches, cylinders, planes, ogees, a large selection of perspectives, and a globe.

The Distortion feature is located in the Transform menu. It can be accessed with no
menus pulled down by typing [&] on your keyboard or clicking on the [&] button in the
side menu bar.

Accessing distortions while editing a single line of text, allows you to distort the entire
line or portions of the line being edited. If the distortions box includes areas of other text
lines, they will not be distorted. To include multiple text lines in a distortion, use the
Group Edit function or select a group before selecting [&] for Distortion.

Setting the Distortion Box

After selecting [&] Distortions, the Status Bar under the menus starts blinking and
then shows instructions on how to set the Distortion Box

Drag Rt mouse to set distortion area; Click Lt mouse to keep same area

Where Rt mouse means that you drag and click the right mouse button to set a
new Distortion box (the same way as if you are zooming). For an existing
distortion, if you want to keep the same Distortion box but edit the distortion
parameters or change distortion type, you can left mouse click inside of the old box
(displayed in green) then change parameters.

NOTE: THE BOX MAY BE POSITIONED TO ENCOMPASS ANY OR ALL PORTIONS OF A LINE.
ONLY ONE DISTORTION CAN BE APPLIED TO A LINE OF TEXT.

To set the dimensions of the Distortion box, the starting point must first be
established. Use your mouse to move the cursor to the desired starting point and
begin dragging with your right mouse button down. The PgUp/PgDn keys can be
used to change the incremental cursor movement and grid alignment while
selecting the Distortion area. PgUp will increase while PgDn will decrease the grid
movement.

You can see a red box being drawn with one corner pinned to the drag starting
position while the opposite corner follows your mouse. When the red box
surrounds the exact area you have in mind, release the mouse button.

The Distortion display window will be presented for you to view and select a
distortion.

Selecting a Distortion

Select a distortion by double clicking your left mouse or using the keyboard arrows
or type the distortion number located to the left of the distortion label. A preview of
how that Distortion applies onto your area will appear to the right of the list. The
blue box shows the area you have selected, the green grid, outlined in red
represents the same area after the Distortion is applied.

To accept a selected distortion, click the OK button or press [Enter] on the
keyboard. Accepting a distortion automatically exits you from the Distortions sub-
menu and returns you to the Stencil-Art design screen, then updates the drawing.
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To exit the sub-menu with no changes, click on the Cancel button or [ESC].

NOTE: PREVIEWING DISTORTIONS WILL NOT AFFECT YOUR LINES BEFORE CONFIRMING
THE SELECTION.

Input Distortions

If you selected an "Input” Distortion to create your own effect, the distortions menu
will change to let you set control values and preview effects while customizing the
selection.

There are 9 "Input" Distortions to choose from. Depending on the one you select,
various parameters will needed to be set.

You can set any parameter with the mouse by clicking on the spinning arrows or
checking / unchecking options. This way, you will get an instant preview update. If
you are typing the values, you will need to click the View button for preview to
respond.

Using the spinning buttons will produce adequate incremental change. If you need
to set a number that is been skipped, because the step is too big, just type the
number and click on View.

Input Stretched Box - This distortion allows you to manipulate the box appearing
on the screen by relocating (stretching) each of the four corners of the box
independently. Move the active corner with your mouse and click the mouse to
confirm the location. Set the lower left corner first, then the lower right, upper right
and finally, the upper left corner.

7. Input Wave - The distortion allows you to set the number of cycles, amplitude
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(height) of the cycles, and the starting position in the cycle for both the upper and
lower waves.

Input Wave parameters Top and Bottom respectively:

CYCLE - Enter a value greater than or equal to zero representing the desired
number of upper cycles.

AMPLITUDE - Enter a value representing the desired height of the cycles.

START CYCLE - Enter a value representing the desired starting position of the first
cycle. Values may range from 0 to 2.

Input Peak/Notch Top/Bottom - This distortion allows you to specify the location
within the distortion box of the peak/notch, the displacement (height) and whether it
will appear at the top, bottom or both. The range of appropriate value entries is
from 0 to 100, which represents a % of the total width of the distortion box from left
to right.

Input parameters:

LOCATION OF NOTCHIPEAK - Enter a value from 0 to 100 as a % of the width of the
distortion box.

DISPLACEMENT OF NOTCHIPEAK - Enter a negative height value to generate a notch,
and a positive value to generate a peak.

NOTCH/PEAK ON TOP - Check the option for the notch/peak to appear on the top.
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29.

33.

37.
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NOTCHIPEAK ON BOTTOM - Check the option for the notch/peak to appear on the
bottom.

Input Peak/Notch Left/Right - This Input distortion allows you to specify the
location and the displacement (height) for the peak/notch and on which side it will
appear, left, right, or both. The range of appropriate value entries is from 0 to 100,
which represents a % of the height of the distortion box from bottom to top.

Input parameters:

LOCATION OF NOTCH/PEAK - Enter a value between 0 and 100 as a % of the height
of the distortion box.

DISPLACEMENT OF NOTCHIPEAK - Enter a negative value to generate a nofch, or a
positive value to generate a peak.

NOTCH/PEAK ON LEFT - Check the option for the notch/peak to appear on the left.
NOTCH/PEAK ON RIGHT - Check the option for the notch/peak to appear on the right.

Input Outside Corner/View - This distortion allows you to specify where the
outside comer will be placed in relation to the distortion box. A zero entry will place
the corner to the left side of the box. The range of appropriate value entries is from
0 to 100 and represents a % of the total width of the distortion box.

Input parameters:

CORNER POINT LOCATION - Enter a value between 0 and 100 as a % of the total
width of the distortion box to specify a corner point location.

BEV, PEV, WEV - 1 Bird's Eye View
2 People's Eye View
3 Worm's Eye View

Input Inside Corner/View - This distortion allows you to specify where inside
corners will be placed in relation to the distortion box. A zero entry will place the
corner to the left side of the box. The range of appropriate value entries is from 0O
to 100 and represents a % of the width of the distortion box.

Input parameters:

CORNER POINT LOCATION - Enter a value between 0 and 100 as a % of the total
width of the distortion box to specify a corner point location.

BEV, PEV, WEV - 1 Bird's Eye View
2 People's Eye View
3 Worm's Eye View

Input Outside Horizontal Corner - This input distortion allows the user to specify
where the corner will be placed in relation to the distortion box. A zero value will
place the corner on the lower side of the box. The range of values to be entered is
from 0 to 100 as a % of the height of the distortion box.

Input parameter:

CORNER POINT - Enter a value between 0 and 100 as a % of the height of the
distortion box.
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53. Input Inside Horizontai Corner - This distortion allows the user to control
placement of the corner in relation to the distortion box. A zero value entry will
place the corner at the lower edge of the box. A value must be entered ranging
from O to 100 as a % of the height of the distortion box.

Input parameter:

CORNER POINT - Enter a value within the specified range to place the corner point
location.

58. Input Arch Plane Upper/Lower - This distortion allows the user to controi the
amplitude of the upper and lower arches to get the desired affect. Amplitude refers
to the height of the arch.

Input parameters:

TOP AND BOTTOM AMPLITUDE - Positive values arch upward; Negative values arch
downward.

Modifying Distortions

Once a Distortion has been set, the X,Y location can be changed. You can also stretch
the line using the First Set of Handles. The distortion box will be resized proportionally

or moved to the adjusted X,Y location. If you change other parameters, make sure the

new values have not caused the text to extend outside of the Distortion box.

Changing Distortions

To retain the same Distortion box but change the applied Distortion, click your left
mouse button when prompted to set the Distortion box. The Distortions display will then
appear for you to make a new selection. The previous parameters for the Input
Distortions will available for editing.

Turning Off Distortions

The Distortion for a line is retained until it is turned off. To resume normal, undistorted
text for a line, select entry # 0 from the list, DISTORTION OFF.
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Output Menu

This menu allows you to output your sign or select and configure your plotter, printer
and CAD file output devices.

Configuration Tab - From the Output Tab select the device that you want to configure,
then click on Configuration to change the tabbed dialog. Once configured, parameters
can be saved as permanent defaults in Stencil-Art. Parameters not saved will only
remain active for the current work session.

Output Tab - All parameters which affect final production of your sign may be adjusted
from this menu. This menu can only be accessed if there is a sign in progress and at
least one output device has been configured using Output | Configuration menu.

Configuration Tab

PLOTTER-1 and 2 and PRINTER are optional devices which must be configured to be
utilized. PLOTTER-1 and PLOTTER-2 may be configured as different plotters or the
same plotter with different panel sizes for variations in media size. Plotter or printer
output may be to an on-line device on any COM (serial) or LPT (parallel) port. A sign
may also be output to a plot (.PLT) or print (.PRN) file for post processing by programs
and plot servers which read plot files.

CAD FILE output allows you to capture information in .DXF (Drawing Exchange File)
format. This file may be imported by a variety of CAD and compatible programs to
combine and modify text and graphics. CAD files may also be created in the .DWG and
‘GCD format for compatibility with Generic CAD.

Plotters

Plotter Selection - When you select Plotter-1 or 2 as the device, a window will display
a list of the most common plotters which Stencil-Art supports. Scroll through the
choices using the arrow keys and make an appropriate selection.

The basic protocol of each plotter is displayed to the right. HPGL-1 uses full
initialization (IN;) and sends the plotter to the absolute zero home position. HPGL-2
uses partial initialization (DF;) and does not output the homing command.
Otherwise, HPGL-1 and HPGL-2 protocols use similar logic for plotters with lower
left origin. But, because the frame advance of each plotter may be implemented
differently, selection from the list is important for proper production.

Castor Radius - This feature supports ink pens, hot tips and a variety of castor (drag)
knives. If available to your plotter, Knife Control will prompt for a Castor Radius
value. If you are using the knife compensation built into your plotter, be sure the
Stencil-Art Castor Radius value is turned off.

The value entered for Castor Radius should reflect the approximate size of the
knife blade you are using. For small knives, a typical value of .015 should be
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entered. You can test this value by cutting the capital "H" in Helvetica. If the
corners are not precisely square, the value should be increased to .016 or .017 and
tested again. For larger knives, a typical value of .045 should be entered.

For pen or hot tip tools, a value of zero must be entered so that castor
compensation will not be computed by Stencil-Art.

Castor Radius may be turned ON and OFF in the Output menu.

Maximum Arc - If the plotter selected uses a tangential tool, the maximum rotation

Pen

angle allowed with the tool down must be entered. The Maximum Arc value
prevents excessive rotation of the tool while it is embedded in a plotting material.

For cutting purposes, a value between 10 and 30 degrees is suggested. The
tangential tool will be lifted when two intersecting lines form an angle greater than
the specified entry. Smaller angles will lift the pen more often. For pen plotting, a
zero (0.0) value entry prevents the tool from lifting even at sharp corners.

If you are operating a Wild TA30 plotter, the Roll Feed option will also appear.

Velocity - This selection allows you to set a Pen Velocity when configuring
PLOTTER-1 or PLOTTER-2.

Pen Velocity is the cutting speed of the plotter tool. Stencil-Art prompts for a
number between 1 and 99, 1 being the slowest, and 99 bring the fastest. If Velocity
is set too high the pen or tool (knife) will skip. Select higher velocities for ink on
paper. For tools, select medium to low values.

Pen Velocity may also be accessed from the Output menu under Details at the time
of production.

NOTE: IF YOU SELECT OMNICAD AS THE PLOTTER DRIVER TO DRIVE A GERBER PLOTTER,
YOU MUST USE THE PEN VELOCITY ENTRY TO INDICATE PEN OR KNIFE CONTROL. SELECT
AN ODD VELOCITY VALUE TO TURN OFF THE TANGENTIAL TOOL CONTROL IN ORDER TO
ALLOW THE PLOTTER TO ACT AS A PEN PLOTTER. AN EVEN VELOCITY SETTING TURNS ON
TANGENTIAL CONTROL FOR CUTTING.

Panel Size - Panel Size refers to the maximum output area of the selected device.
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Although your sign or drawing may be of any size, these values correspond to the
limitations of the device and materials you are using. Refer to your plotter or printer
manual for setting the maximum production area.

This entry automatically defaults to an approximate Panel Size for the device you
are configuring.

The Panel Size for your plotter should be limited to the maximum plotting area as
specified in your plotter manual, even if the sign you are creating exceeds these
limits. If you are using narrow material, the panel size should be limited to the width
your plotter will cut or draw on the material. Pinch roller placement will affect the
width (Y) value.

Signs which are larger than the Panel Size specified in Stencil-Art will be drawn as
multiple panels. Panelization allows you to create very large final drawings using
the smaller production panels as mosaic pieces.

If entries on your plotter console can physically limit the size of a production panel,
be sure that the Panel Size entered into Stencil-Art is SMALLER in X and Y than
the limits you set on your plotter.
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To Disk File - Plot files may be captured for export to other packages or output
devices. This option allows you to create a plot file by saving plotter output data to
a PLT disk file. The file name is requested at the time of production.

Printers

Printer Selection - When you configure a PRINTER as your output device you will be
able to chose from a list presenting all printers that are set up on your computer. If
you can not find the desired printer, there could be two reasons:

First: This printer is not listed under Printers in My Computer (Windows
environment), which means your printer is not set up vet.

Second: Look at the printer documentation for possible protocol compatibility. If not
listed under Printers, set up your printer like another that is compatible with it.

Printer Properties - Press the “Properties” button if you want to configure or check
any of the following features:

Device Resolution - Graphics section. Device Resolution allows you to set the
appropriate resolution for your printer. Depending on the printer, the system will
show you a list of resolutions.

Paper Size - Paper Section. The settings will affect the values for panel size in
the Output menu.

Orientation - Paper Section. You have the choice between Portrait and
Landscape.

Paper Source - Paper Section. Configure the paper feed of your printer manual,
“tractor or from bin.

Eprrt files
When configuring an Export FILE output, make sure the Panel Size exceeds the

drawing size of the file to be exported. If the Panel Size is not large enough to include
the entire drawing being exported, only portions of the file will be exported successfully.

If you need to export a plot (.PLT) file to Corel, look under Plotter configuration for it.

Plotter Port Configuration

Stencil-Art supports most plotters even though the manufacturer may not provide
Windows drivers. Windows requires some way to know that there is a device
associated with a port. Stencil-Art provides the following solution for all plotters:

Install “Generic / Text only” printer driver that is supported by Windows. Select Add
Printer from the Control Panel | Printers folder. Select local and choose
Manufacturer “Generic”. From the printers list choose the “Generic / Text only”.
Then select the port (network names are allowed).for your plotter and chose Next.
Change the “Printer Name” to “PLOT1" or "“PLOT2” (5 keystrokes only - no
spaces or other spelling allowed), corresponding to “Plotter-1" or “Plotter-2" in
Stencil-Art. Do not select this “printer” as default if not necessary and do not output
a test page.
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If you open the Control Panel | Printers folder, you will find a new printer icon,
named "PLOT1" or "PLOT2". Select the icon and check the “Spool Settings” in the
File | Properties menu, Details tab. Click on “Spool Settings” button. SPOOLING
must be selected ON to START OUTPUT AFTER THE FIRST PAGE with RAW
data.

If a serial port plotter is connected, select the correct COM port and use the Port
Settings menu for Bits per second = 8600; 8 data bits; parity none; 1 stop bit and
Hardware (NOT Xon/Xoff) flow control.

The driver that you have selected will now appear in your printer list for any
Windows application. Remember that this channel is really your plotter. By
establishing that a port has a driver, Stencil-Art can then send data to the spooler.

When a driver and a port are established, Stencil-Art will send to the device via the
Windows spooler without driver interpretation. Stencil-Art uses the Spool program so
that the plotter output, like printer output can operate in the background. Both plotters
and your printer can be operated simultaneously.

In the Output | Configuration menu for Stencil-Art Plotter-1 and Plotter-2 devices, if you
need to output to DISK, no changes in the “PLOT1" or *PLOT2" driver setiings are
necessary. Just select the “Disk” option.

Output Tab

Output can be as simple as selecting Output menu and Produce All or Output Lines,
once an appropriate output device has been selected. Produce All outputs all lines of
text contained in the sign currently in progress. Output Lines processes the active lines
previously selected from the Select Lines features. The Output menu allows access to
all output control features including modification of Panel Size, sign orientation, plotter
velocity.

Device - This feature displays output devices previously configured in Configuration
including PLOTTER-1, PRINTER-1, PLOTTER-2 or CAD FILE for selection. For
production output, the appropriate device must be chosen before selecting Output
Lines or Produce All. The manufacturer and port selected in Configuration for the
chosen device are displayed as a window title.

Panel Size - Panel Size is the smaller of the maximum production area for each output
device or the useable medium in the device. Although your sign or drawing may be
of any size, the values entered here correspond to the physical limitations of the
plotter, printer, or materials you are using. If output is to a CAD file, Panel Size
should be equal to or greater than the Drawing Size of the sign to be output.

If the Panel Size is smaller than the Drawing Size of your sign, Stencil-Art will
output the sign in a series of panels. Refer to your plotter or printer manual for
device limitations and the Configuration menu to set the maximum Panel Size.
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J Panel Offset -J Panel Offset allows you to enter an X.Y value as the origin of the
plot. J Panel Offset can be useful for repeating cuts or plots of a specified window.

Set Window - The Window function can designate an area other than the specified
Panel Size to be output. When E is selected, the maximum window size for a panel
is displayed. Use the arrow keys or mouse to move the window box to relocate the
lower left corner of the window.

To resize and relocate the window box, use the arrow keys or mouse to move and
set the lower left corner. Once the lower left comer is positioned, press [Enter] or
click the mouse to retain the location. Move the upper right window corner with the
arrow keys or mouse and press [Enter] to retain this corner.

After establishing the dimensions of the window, a prompt will ask if you wish to
"Plot in Position”. Window plotting in place is useful to double cut or re-ink your
sign. If you enter [Y], the lower left corner is recorded as the J Panel Offset, and
the Window will plot at its designed position. Enter [N] to plot the Window at the
0,0 output device origin. Use the J Panel Offset feature to plot the window at a
specific position.

The J Panel Offset feature allows you to place and plot the window at a specific
position other than 0,0 origin or the designed location. You can use this feature to
conserve materials or create special plotting effects. If necessary, set the J Panel
Offset after setting the window area. See J Panel Offset for more information
regarding this feature. '

Select [W] to output the specified window area.

Margin Panels - This feature is only applicable when your Drawing Size exceeds the
plotter Panel Size (Panelization). Margin is only applied when the first of
successive panels is not panel 101. The left edge of the panel group is produced
so that when mounted, it should overlap the preceding panel by the margin value.
The bottom edge of the panel group is produced so that when mounted, it will
overlap the panels below by the margin value.

Scale Type - This feature contains three options which can be used to control your
sign size.
NORM - Displays the scale factor setting of the Sign Layout sub-menu and allows
you to change the scale factor for X and Y. The drawing may be scaled
proportionately by entering the same scale factor for X and Y or scaled differently in
width and height by entering different values for X and Y.

FIT - Scales the drawing size to fit in the panel size of the selected device. This
entry is useful for proportional scaling a full size drawing designed for plotter output
to fit a printer panel size for a preview.

FILL - Scales the drawing size to fill the extents of the pane! size. This entry does
not maintain a proportionate and equal scale factor in Xand.

Fit or Fill will never scale larger than 100%.
Rotate - Rotate allows you to turn your entire drawing size. This may be useful to

conserve vinyl. Rotation can be used to change between Portrait and Landscape
to a printer when drawings are properly scaled. The three Rotate options are:

OFF - Outputs the drawing as designed with no rotation.
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-90 - Rotates the drawing clockwise 90 degrees.
+90 - Rotates the drawing counter-clockwise 90 degrees.

Invert - Invert allows you to flip or mirror your entire drawing.
OFF - Turns off Invert to output as designed.
HORZ - Flips the drawing horizontally.
VERT - Flips the drawing vertically.

¥Weed Border - For vinyl cutting, this option assists you in weeding your sign and
minimizes the amount of wasted vinyl. For pen plotting or printing, the Weed
Border may be used to draw a border around your sign.

OFF - No weed border is produced.
FULL - The weed box is around the full Drawing Size.

LINE - The weed Border only cuts or draws around the lines of text specified.
When set to Line, you are prompted for a weed border value. This value is the
distance from the extents of the text area to the weed border. A zero value will cut
on the limits of the text.

In the panelization mode, the Full weed border will draw or cut a border at the left of
the first panel, the right of the last panel and the top and bottom of all panels.

NOTE: NO VERTICAL LINE IS CUT BETWEEN SUCCESSIVE PANELS.

Shaded Output - Shaded Output determines whether text is output to the production
device filled or outlined. When Shaded Output is checked, the outline of text is
filled with vertical lines spaced apart by the Shade Density value associated with
individual text lines (See Line Parameters, Shade Density). The shading in-fill is
produced first and the final outline is produced last. For routers and engravers, this
removes the large mass of material and the final outline pass will produce a clean
tooling edge.

When Shaded Output is not selected, only the outline of text is displayed.

NOTE: FOR VINYL CUTTING APPLICATIONS, SHADED OUTPUT MUST BE OFF.

Curve Res. - Curve Resolution lets you change the resolution of curved lines when
plotting a sign. The default value of 1.0 is normal and usually adequate. However,
when producing text that is exceptionally large (10 inches and above), slightly
increasing the resolution may help refine the curves. Since it is possible to over
resolve curves, making plotted output very jagged and slow, the maximum value for
this entry is 8.0.

Details - Select Details if you are outputting to a plotter and it will display more options.

L Pen Override - Selecting an Override Pen number is only applicable to multiple pen
plotters and is not used for vinyl cutting. The Override Pen, if non-zero, is used to
output all lines of text regardless of the individual pen numbers assigned to each
text line in the Edit menu.

The Override Pen remains set until changed or until you quit Stencil-Art. An
Override Pen of zero (0) turns off this option so that text is plotted with the pen
number assigned to each individual text line.

Velocity - This control refers to device velocity or tool speed. Selecting it allows you to
change the Velocity by entering a number between 1 and the maximum speed of
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the configured plotter. The maximum value varies depending on the plotter being
used. Enter a high value for ink pens, a medium value for knives, the lowest value
for hot tips. If velocity is set too high the pen, knife, or hot tip may skip.

Knife Control - If a Castor Radius value has been established for PLOTTER-1 or
PLOTTER-2 in Configuration, you may turn Knife Control on or off. DO NOT turn
on castor if your plotter is already compensating for the linear knife.

Usage Count - Displays the number of outputs to the present output device. It keeps
track of the device usage for both plotters and the printer. This information may be
useful in estimating tool wear and use time before replacement. Double click the
counter and you will be prompted to reset the count. If you choose “Yes’, a file with
the Production History will be displayed. This summary of production displays each
output job name, size of job and exact date and time of output. If the Production
History file is manually edited, the usage count will be shown in red until it is reset.

Qutput Buttons

Select Lines Button - This feature allows you to select which lines are output. See
Select Lines from Edit menu.

When output is complete, the lines selected for output remain active for editing.

Frame Advance - Frame Advance advances the plotter one inch beyond one full panel
length. or drawing size, whichever is less, and resets the origin to continue plotting.
This feature is only applicable for PLOTTER-1 and PLOTTER-2.

Out'put Lines - Output Lines establishes communication and outputs the presently

‘selected lines to the device shown at the top of the output menu. Select Lines may
. be used to alter the lines selected.

When the device is set to CAD FILE or a plotter or printer is configured to a disk

file, Stencil-Art opens that file for output in the appropriate format and prompts you
for a file name.

If the Panelization mode is required, you will be prompted for Panels to output. See
Panelization.

For any output device, if an invalid communication status is detected, the error
message, "DEVICE NOT PROPERLY SET", will appear on the screen. This error
usually indicates a cabling problem or the plotter or printer is not on-line or the
device is configured to the wrong port.

The F2 key will stop output generation to the screen and output device. Devices
with buffers will continue to run until the device buffer empties.

Stay at Plot End - The option is only displayed for plotters allowing frame advance.
When the option is checked, the output finishes at the maximum X point plus 1 inch
and changes the X coordinate of the origin of the plotter to the new position. The
option is unselected (not checked) by default. Once selected, the option will retain
its value until the end of the work session. If you are planing on sending multiple

jobs (or multiple copies of the same job) to the plotter, be sure to select Stay at Plot
End option.
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Embossed Output — Appears only if a Braille Visual Font is used. Leave this option
checked (default) for automatic substitution of visual fonts to use true Braille
embossing or engraving fonts during output. Clear the check box for inking
readable text before embossing on Braille tactile paper.

NOTE: ALWAYS PUT A REGISTRATION MARK IN A DOCUMENT THAT INVOLVES TWO
PASSES THROUGH OUTPUT DEVICES. A SMALL “L” SHAPED MARK, PLACED AT X=0, Y=0
WILL HELP WHEN SETTING THE DEVICE ORIGIN FOR THE SECOND PASS.

Composed BW Printout - This option is only available for output to a printer. Text and
graphics of your sign are composed so that upper layers (higher numbered lines)
erase the conflicting areas below. Line # 1 is the bottom layer. Line Order is
significant for the result. The in-fill of each text line erases what has been
composed from preceding lines prior to drawing the text line using double pixel line
thickness. Lines of text that are colored in white are also printed.

Panelization - Panelization is an automatic procedure for on-line plotters and plot files
when the Drawing Size exceeds the Panel Size. It allows Stencil-Art to override the
limits of the plotter and produce a sign of virtually any size.

When Output Lines or Produce All is selected, you are in Panelization if the text
appears on the screen within a series of numbered panels (101, 102, 103). A
prompt appears asking for panels to output. A single panel or group of contiguous
horizontal panels may be output at one time. For signs requiring vertical
panelization, the output process must be repeated for each row of panels.

For each group of contiguous panels, Stencil-Art produces the first panel,
automatically advances your plotter, resets the plotter origin and continues plotting.
The plotter's final position is at the origin or end of the last panel depending on
Stay at Plot End. Contiguous panels are butted with no space between.

Produce All - This function outputs all lines of text in your sign regardless of the lines
selected for editing or output.

Window Output - Window Output produces only the portion of your sign that is within
the Set Window area. The window's lower left corner, as designated by Set
Window, is placed at the plotter origin or J Panel Offset position. Window can be
very useful to output a small area damaged in the larger sign production process or
to re-do a portion where an ink pen ran dry.

NOTE: WINDOW OUTPUT SHOULD ALWAYS BE USED FOR PRINTER OUTPUT IF A LARGER
DRAWING IS SELECTED, USE SCALE TO FIT FOR PRINTERS.

Preview — Displays a preview of the Window Output. For many jobs, the entire design
area will be on a single panel. Select Window Output (without using Set Window)
OR Output Lines (panels 101,101) which produces the same result. The Set
Window option allows you to select a panel other than 101, if you have a multi-
panel job. For all these options, Window Output Preview will help confirm the
output settings.

Tag Ctrl - When a TXT file is attached to a sign (i.e. the TXT file is a data source for
output), the Tag Ctrl button will launch the Tag Control screen. In this screen you
will set the three parameters that control the tag output - Data Fields, Tags per
Page and Page #. These parameters are discussed as part of the Line Parameters
- TEXT topic in this manual. There are different tools to help you set and correctly
use the tag output feature.
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Output Menu - Output Tab

The Text list scroll box will let you preview the text file in page groups. If you
change the Data Fields or Tags per Page parameters you should select the
Refresh button so that the Text List is regrouped with the new settings. Pages are
separated by wavy lines that will not be part of output. The data between them is
the actual content of the page.

Auto Page Control — This option if checked (by default), will increase the Page #
count automatically after each output.

Find Function (Ctrl-F and F3) will let you search the text list for a particular word.
The search is not case sensitive. Type [Ctri+F] to set the search string. Push [F3]
to repeat the search.

NOTE: DOUBLE CLICKING THE TEXT LIST RESETS THE PAGE # COUNT ACCORDING TO
YOUR SELECTION.

Notepad Link opens the attached .TXT file in Windows Notepad. Double click the
Notepad icon to start editing the file. When done editing, select the Notepad File |
Save menu and Refresh in the Tag Control screen in Stencil-Art. This feature can
be used for editing the tag list as well as to add new tag information.

Preview Button is a Window Output Preview function. Selecting this displays the
output on a white screen with a light blue grid. The Info button will provide
additional information about Window Size and Output Offset according to your
settings in the Output menu. It will also show the frequency of the grid lines. The
grid lines are only preview elements and not part of the actual output.

Output Button If you have designed your sign to be a tag template for a single
page (as recommended) you can output directly from the Tag Control screen. If
you are using the Attached file function with a multi-panel output you must output
from the standard Output menu and use Output Lines to set first and last output
panel.

Browse button is a way to attach a .TXT file with a different name or from another
folder. The program will use a different file as the data source during production
than the file named originally in the template file. Thus, a simple template can be
used with multiple and differently named text files. All attached files must have the
TXT extension. This will not affect the text shown in the variable lines because the
changes in the sign file are not permanent.

Exit button takes you out of the Tag Production screen and back to the main
Output menu. You will be prompted to “Save Production History”. Saving
production history includes saving the tag controls, present page number and the
name of the .TXT file used during last output.
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Text - Text refers to the letters, numbers, and special characters in a sign. Text also
refers to graphic files and attached name list files. Up to 80 characters may be
entered per line of text. European characters may be entered using the [ALT] key
with the appropriate 4 digit key pad entry (starting with a 0). See the Extended
Character Set for the numeric references of all font characters.

When Stencil-Art is initiated, the program begins in an UNTITLED sign. The T on
the side menu bar is highlighted indicating that Text must be entered by typing T on
your keyboard or accessing the T in the side menu bar with your mouse. This
starts a new sign.

NOTE: ACCESSING T TEXT WITH YOUR KEYBOARD OR MOUSE WHILE EDITING A SIGN FILE
IS A SHORT CUT TO PULL DOWN THE EDIT TEXT SUB-MENU.

As an alternative to typing simple text you have the option to:

- Attach a tag file [F3];
- Select a .GNT graphic file from a permanent Stencil-Art library [F4];
- Bridge temporarily an .EPS, .Al, .DXF or .PLT graphic file [F5].

The option to attach a tag .TXT file (ASCII text file) gives you an easy way to
automate the production of labels, name tags, street name signs, etc. using
standard output from a client database or a file created in any text editor.

To be available for attachment, the .TXT file needs to be stored in the main Stencil-
Art folder. The name of the file should be a valid DOS name, i.e. up{o 8
characters (letters and/or numbers) and no punctuation. When you prepare such a
file there are a few simple rules to follow:

1. All tags should have the same number of text lines. Empty lines are allowed.
Text can have up to 80 characters, the rest will be truncated.

Use carriage return [Enter] as a line separator.

Tabulation will be ignored.

If needed, spell check the text prior to using it in Stencil-Art.

in Stencil-Art you will need to design a template output page.

Phode G PO

, = . Create one complete tag in the lower left corner of
( Mr. Teodor Been | the design area. Assign all text parameters

‘ HOBBY: cocking \ (height, font, italic, rotation) to both variable and
permanent lines. Use T Text and F4 as
appropriate.

wood curving

SPORTS: baseball '
)

tenmis
!, | ROOM 4006 | When designing the layout, use (long name)
S S | | sample entries of the text that is expected from the
cpzasit attached .TXT file. Note the maximum length you
intend to use for each variable line.
In our example, the words “HOBBY:", “SPORTS:"” and “"ROOM” + the two frames
will be repeated on every tag (permanent lines).

When the design is complete, replace the text of each variable line (6 lines in our
example) using T Text [F3] to change the text to be the attached Filename. TXT.

For the first variable line, you will select the text file name, i.e. "ALL.TXT" which will
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be remembered for following entries. For al! lines, you will be prompted for the text
maximum edit length. Extra long text will be compressed to fit into as needed.

If the attached .TXT file has blank/empty lines, they will be produced as blanks
during output i.e. someone only having one hobby in our example.

NOTE: SEPARATION BLANK LINES MAY BE INCLUDED IN THE .TXT FILE BY TEXT
PROCESSING PROGRAMS OR FOR CLARITY. DESIGN YOUR TEMPLATE TO ACCOUNT FOR
THESE EXTRA BLANK LINES. THE PLACEMENT OF SEPARATION BLANK LINES IS
INCONSEQUENTIAL. BE SURE THAT THE TEMPLATE LINES ORDER OF USE MATCH THE
ATTACHED FILE ORDER OF INFORMATION.

all.txt . Tip: Select fonts based on the maximum text
| HoBBY: allext | compression needed for the attached file words.
. alltxt i i :
| SPORTS: allixt | Design the tag with the most extreme text cases

St | from your file. Then substitute the text using T Text

‘ iROOM all.txt ‘ l F3. Text maximum length must be changed using T
S et | Text F3.

After the editing changes, our tag is going to show the text file name instead of the
text that the tag was designed with. Be sure the variable lines appear in the same
order in the sign as in the attached file.

NOTE: TEST YOUR TEMPLATE AND ATTACHED FILE USING OUTPUT TO YOUR PRINTER OR
PLOTTER BEFORE GOING TO PRODUCTION. THE EDIT | SELECT LINES | REORDER
FUNCTION CAN BE HELPFUL TO CORRECT LINE ORDER PROBLEMS.

Change the drawing size to the material size, then step and repeat the tag for
optimal use of the material. In our case, the tags are 3.75"x2.5” and we are going
to engrave them on 12"x8" plastic stock. We will set the drawing size to 12"x8” and
apply Group | Step & Repeat from the Edit menu. We have space for 3 columns
and 3 rows if we repeat using Width parameter 3.9” and Height 2.65” so there is a
little space between the tags to cut them apart.

In the Output menu, use the Tag Ctrl button to set the three Tag Control fields.
Data Field Count represents number of variable lines per tag and in our case it
would be set to 6. Tags per Page would be 9 (3 rows x 3 columns). Page number
is changed each time a set of tags produced.

NOTE: IF YOU NEED TO OUTPUT A SINGLE TAG FROM THE TEMPLATE, SET A WINDOW
AROUND ONE TAG. SET TAGS PER PAGE TO 1 AND SET THE PAGE NUMBER TO THE TAG'S
STARTING LINE IN THE ATTACHED TEXT FILE.

In some cases, text file information may apply repeatedly to a page rather than per
tag. In the above example, imagine that you need the page layout to contain 9
copies of the same tag and the next page to contain 9 copies of the next tag, and
so on. For such scenarios you can lock the Data Field Count per page by pushing
the Key button next to it. The Tags per Page option will be ignored and the count of
the variable lines will be used repeatedly for the whole page.

Locking the Data Field Count per page can be used to serialize output sheets. For
example: Each sheet has 20 tags and they need to be numerated — 1/xx, 2/xx, ...,
20/xx, where the “xx” is the sheet number. The text file would have each sheet just
once. In the Tag Control menu, you would set the Data Field Count to 1 and lock
the field so that all tags on the page will have the same sheet number from the text
file. As the page number increases, successive entries in the text file will be used.
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The text entry box is used also to include graphics in a sign. If you want to include a
graphic, press [F4] when the text entry box is presented. A graphic files list will be
displayed. You can select (click) a file name and preview (double click) the graphic.
To accept the graphic as a line of text, press [Enter] or click the “OK” button on the
screen when the graphic is selected (highlighted). The Path entry allows you to
view and access graphic .GNT files that may be located in other directories. The
[Del] key will send unwanted .GNT files to the Recycle Bin.

NOTE: SIGNS THAT CONTAIN BRIDGED GRAPHICS (SELECTED WITH [F5]) CANNOT BE
SAVED. THE .PLT, .EPS OR .DXF GRAPHICS ARE CONNECTED TEMPORARILY. FOR
PERMANENT SIGNS, YOU MUST IMPORT THESE GRAPHICS TO A .GNT LIBRARY AND THEN
SELECT THE FILE USING [F4].

Text Blind Menu Entries

Blind Menu Entries are keys that assist in correcting spelling errors, fine tuning letter
spacing, and individual character manipulation. These keys are not displayed in any of
the Stencil-Art menus and are only active during Text entry:

[F6] - Checks for spelling errors in the highlighted portion of the text entry. If
nothing is selected, the whole text of the line will be checked.

[F7] - Floats the following character up 1/5 of Height from text base line. The text
will show U for each entry.

_[F8] - Floats the following character down 1/5 of Height from text base line. The
text will show AV for each entry.

[F9] - Increases space between letter pairs to move letters FARTHER APART by
1/20th of a space key. The text will show ”R for each entry.

_[F10] - Decreases space between letter pairs to move letters CLOSER
TOGETHER by 1/20th of a space key. The text will show L for each entry.

Text Case [Ctrl + T] — Gives you an opportunity to change the letter case of the line’s
text parameter. Three options are available — lower, upper and title case:

Lower Case — changes text to all lower case letters;
Upper Case — changes text to all capital letters;

Title Case — changes text to lower case with the first letter of words capitalized;

Font - The Font entry determines the typeface assigned to a line of text. It is the
description of a graphic if a .GNT file is included as text. Selecting F accesses the
Font selection display showing the fonts available and the current font being used.

The font selection window is used to select a font for the current line of text. You
can also change the path location to access a different font list.

If you have more fonts than can be listed at one time, press the [PgUp] or [PgDn]
keys or click on the vertical bar in the font listing to scroll through the list a page at
a time. Using a keyboard, you can select a font by entering the number code listed
to the left of the desired font or by using the keyboard arrows to highlight the font
and pressing the OK button. To preview characters A-Z/a-z of the selected font,
select or highlight the font by clicking your left mouse button on the font number or
name. Double click your left mouse button to preview font characters. Once the
font preview is invoked, enter any letter A-Z/a-z on your keyboard to see the
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character. Press [Enter] or click your mouse on OK to accept the font selection and
exit the font display.

A new font selection will default the Between Space and Width to normal text
values if I Mode is set to AUTO,. The Edit Length of the text will be automatically
recalculated for the new font.

The Font Manager has been incorporated into the Font Selection menu, letting you
add, remove and build fonts within Stencil-Art. For more comprehensive
information see “Font Manager.”

Height - Height changes the text or graphic height of the current line. For text, Height

represents the capital letter height. All lower case letters and numbers are
proportional to the upper case Height. For graphic files, Height is the vertical
dimension of the image.

To access the Height entry, press H on your keyboard or click your left mouse
button on the “H” button from the side menu or on one of the Height text handles.
Height can then be set by typing a keyboard value or by dragging your mouse. The
current value of the mouse drag is indicated in the status line.

Curved letters such as "O" in many fonts may extend below the lower baseline and
above the capital letter height depending on the original design of the font.

When | Mode is set to AUTO, changing Height will normalize an active line. This is
identical to using any corner text handle from the first set.

NOTE: USING THE UPPER RIGHT TEXT HANDLE TO CHANGE THE HEIGHT VALUE WILL
MAINTAIN NORMAL UNDISTORTED TEXT. IF YOU HAVE PREVIOUSLY SET EDIT LENGTH OR
WIDTH AND NEED TO MAINTAIN THE VALUES, ADJUST HEIGHT WITH THE MIDDLE TEXT
HANDLES. IF YOU MISTAKENLY USE A CORNER TEXT HANDLE ONCE EDIT LENGTH OR
WIDTH HAVE BEEN ADJUSTED, YOU CAN USE THE UNDO FEATURE TO "ERASE" THE LAST
ENTRY.

When ! Mode is set to MANUAL, changing Height does not affect Edit Length or
Between Space or Width proportions. This is identical to using the upper or lower
middle text handles from the first set. Refer to the distortion comments under Edit
Length.

Edit Length - Edit Length is the length of the current line of text. To change the Edit
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Length to force text to fit a certain length of space. Select [E] on your keyboard or
click the “E” button from the side menu or use the Edit Length text handle from the
first set and drag your mouse or type a keyboard value. Press [Enter] or click your
left mouse button to set the new value. Stencil-Art will condense or extend text to
any desired Edit Length by adjusting both the Width and Between Space
parameters. Using any corner text handle from the first set changes Height and
Edit Length simultaneously to maintain a 100% Width value.

Itis possible to enter a Edit Length and have the Height automatically adjusted. To
set a particular Edit Length and change the Height so the text/graphic is undistorted
(100% Width), type the value and press [Ctrl] key on the keyboard before pressing
[Enter]. This is the opposite of setting Height and having the Edit Length adjusted.

The extended or condensed distortion of character shapes can be judged by the
value of Width and can be seen in the change of the vertical stem versus the
horizontal stem thicknesses. The closer the value of Width is to 100%, the closer
the letter is to its original design shape and proportions.
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For graphic import files, Edit Length is the width dimension of the image. When the
Height of a Graphic is specified, the Edit Length is calculated accordingly for an
undistorted image. When Width is not 100%, it reflects that the graephic image is
distorted proportionally to fit the Height and Edit Length values.

When ! Mode is set to AUTO, the final Edit Length should be adjusted AFTER
Height, Width, and Between Space have been entered as these entries affect the
Edit Length.

NOTE: OUTPUT WILL ONLY PRODUCE THE PORTIONS OF TEXT WITHIN THE DRAWING SIZE
LIMITS SPECIFIED. IF ANY PORTION OF YOUR TEXT DISAPPEARS OFF THE SCREEN, THE
EDIT LENGTH MAY EXCEED THE LIMITS OF THE DRAWING SIZE OR THE X,Y PLACEMENT
MAY NEED TO BE ADJUSTED.

NOTE: STENCIL-ART TREATS HIGHWAY (HWY) FONTS DIFFERENTLY. THE FONT
CHARACTER WILL NOT DISTORT. ONLY THE SPACE BETWEEN LETTERS IS MODIFIED. THE
BETWEEN SPACE VALUE IS DISPLAYED AS A PERCENT OF NORMAL, NOT IN INCHES OR
CENTIMETERS. USING EDIT LENGTH DOES NOT COMPRESS/EXTEND CHARACTERS, IT
ONLY CHANGES THE BETWEEN SPACING. WIDTH IS MAINTAINED AT 100%.

Width % - Width determines whether text is condensed or extended. When ! Mode is
set to AUTO and Font or Height are entered, the Width is automatically set to
100%. This value reflects the percentage of the normal width of the text. When
Width is 100%, text is undistorted. A Width value of less than 100% condenses

text. A value greater than 100% extends text. To change the Width of text, select
W on your keyboard or access the “W” button in the side menu bar with your
mouse or operate with a Width Text handle from the second set. Enter a keyboard
value, or drag your mouse to view the affects of the change.

..For Stencil-Art Highway (HWY) fonts, the Width function is the only function that
‘will distort the letters of text. (See also note under Edit Length.)

Justification - Justification refers to the placement of text at the X,Y location. You can
place text by its beginning, middle, or ending point at the X,Y location. If J is set to
LEFT, text begins at the assigned X,Y coordinates. If J is set to RIGHT the text
ends at the assigned X,Y coordinates. If Jis set to CENTER, the X,Y coordinates
are at the midpoint of the text baseline. For arced text, the X,Y coordinates are at
the circle-center point and the text may be LEFT or CENTER justified.

For keyboard entries, press J followed with L,R or C to access desired justification.
For mouse entries, simply click on the “J” button on the side menu and choose the
appropriate justification.

Mirror - For reverse lettering, choose Mirror ON. Mirror affects one line of text only,
unless selected from the Group Edit menu. Mirror OFF will return the text to its
original image. Mirror produces the reverse image of a line of text, including an
italic slant, while retaining text positioning.

Between Space - Between Space determines the distance between letter pairs in a line
of text. The default value of Between Space is 12% of the text Height. It is
automatically recalculated when Height or Font are selected while in the Auto Mode
(See | Mode). Adjusting Between Space helps to fit text into a particular area
without distorting the letters. (See Edit Length). If Var/Std space is set to Var
(variable), letters will generally touch each other when Between Space =0.0. (For
HWY fonts see note under Edit Length.)
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NOTE: WHEN USING SCRIPT FONTS WITH VARISTD SET TO VAR (VARIABLE) SPACING,
NEGATIVE BETWEEN SPACE WILL CAUSE LETTERS TO OVERLAP.

Var/Std Space - This option affects spacing between letters in a line of text. For Var
(Variable) spacing, spacing is measured between the outline shapes of each letter
pair. In Std (Standard) spacing, midpoints of letter pairs are an equal distance
apart. Standard spacing is useful when multiple lines of text need to be vertically
aligned in columns such as for menu prices.

I Mode - Mode affects the editing results of all Font/Graphic and Height entries. When
Mode is set to Auto, Width and Between Space values are automatically calculated
when Font/Graphic or Height are entered. When Mode is set to Manual, Width and
Between Space are not affected by Font/Graphic or Height entries. Manual Mode
Height entries do not affect the Edit Length but do affect the Width proportion
value. In both modes, a new Font/Graphic selection will change the Edit Length.

% Comment - The Comment feature allows you to enter a line of notes regarding a
particular line of text. Notes on vinyl color, tool adjustment, or scaling values may
be helpful for future reference and shop instruction printouts.

Color - Color allows you to select from a color palette to apply to each line of text on the
screen. Using colors may help you visualize the final sign color balance or to
separate special effects. Output can be selected by color layers.

Pen - Pen numbers can be assigned to each line of text for multicolor plotter output. It
may be useful to coordinate Pen numbers and color assignments for editing and
multicolor printers. The pen assignment can be overridden from the Output menu.

Shade Density - Shade Density refers to the distance between vertical shade lines.
For solid shading effects, a .25 mm pen tip would require a .01" density. A 300
dots per inch printer would require a .003 density for solid coloring, .006 and .009
would produce halftones by shading every second or every third pixel column.
Larger values of Shade Density produce open striping effects. Text and closed
graphic images may be shaded. Single line fonts cannot be shaded and the
density is automatically set to zero. To view shaded lines turn Wire Frame OFF
from the View menu. For shaded output to printers and plotters, turn shade on in
the Output menu.

NOTE: REGARDLESS OF THE SHADE DENSITY VALUE, SHADING MAY BE TURNED ON AND
OFF BY SELECTING SHADED OUTPUT FROM THE OUTPUT MENU. BE SURE TO TURN
SHADING OFF WHEN CUTTING VINYL.

Italicize - ltalicize allows you to slant text forward or backward up to 60 degrees in
either direction. To ltalicize text select [ 1] on your keyboard or with your mouse
click the “I” button from the side menu or access one of the upper corner text
handles from the second set. Move your mouse in the desired direction or enter a
number for the italic angle. Positive values for the ltalic Angle will cause leaning to
the right. Move your mouse to the left or enter a negative number to lean text to
the left. Keep in mind, italicizing text increases the Edit Length. When text is
mirrored, a negative italic value will slant text to the right and vice versa.

Angle of Rotation - This feature pivots the text baseline angle. The text baseline can
be rotated from -360 to 360 degrees. A value of 180 will turn text completely
upside down and in the opposite direction. A value of 90 will place text at a right
angle to the original string of text. The default value of this option is 0 degrees.
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Select [A] on your keyboard and enter a value between -360 and 360. Access “A”
in the side menu bar or one of the Rotation Handles from the second set and drag
your mouse to pivot the text baseline.

Angle Rotate is also used with the Radius Arc entry to create arced text. Inthis
case, Angle determines the position of the text on a circle.

Radius Arc - Radius Arc is used in conjunction with the Angle Rotate eniry to achieve
arced text. The Radius is the measurement of distance between the X,Y circle
center point and the text circle baseline. When the Radius is positive, text will be
clockwise and outside of the defined Radius. When the Radius is negative, the
letters will be counter-clockwise and inside of the defined Radius. For centered text
placement inside of the bottom of a circle, use a negative Radius with a rotation
angle of -80 or 270 degrees.

Select [R] and enter a keyboard value or use your arrow keys to adjust the radius
value. Using a mouse, click on “R” in the side menu and move your mouse up or
down to adjust the Radius value. Press [Enter] or the left mouse button to accept
the value. The text box arcs and a line extending from the X,Y position (circle
center) to the justification point on the arc are displayed. Once arced, the line will
be provided with Text Handles for Arcs.

NOTE: ONCE A NON-ZERO RADIUS IS ESTABLISHED FOR TEXT, THE UPPER LEFT EDITING
NODE WILL CHANGE THE RADIUS OF ARC BY MAINTAINING THE TEXT JUSTIFICATION
POSITION AND CHANGING THE CENTER POSITION (SEE TEXT HANDLES.)

( Char. Angle - Character Angle allows you to rotate each character in a line of text. A
positive entry will rotate the characters counter-clockwise, while a negative value
will rotate the text clockwise. Select “(* in the side menu bar and move your mouse
or use the arrow keys to change character angle direction. Use this feature with
Angle Rotate to align text vertically.

A Caps Height % - This feature scales the first letter and every first letter following a
space in a line of text. The scale factor entered is used to increase or decrease the
size of the letters. To exclude a letter from this feature, introduce the temporary
kemn values to block the * Caps Height feature from applying to that letter.

Example: If your Text line is: Vote For a Winner, and you do not want the “a” to be
affected by this feature. Type the text line as: Vote For [F9][F10]a Winner. The F9
and F10 keys will cancel each other and Capital Height will not affect the word “a”.

X - The X value is the horizontal placement of the selected line of text. To change the
X placement, access [X] on your keyboard or click on the “X=" in the status line.
Accessing X with your mouse allows you to drag the mouse to the right and left
changing only the X value. Click the mouse or press [Enter] to set the position.

Y - The Y value is the vertical placement of the selected line of text. To change the Y
placement, access [Y] on your keyboard or click on the “Y=" in the status line.
Accessing Y with your mouse allows you to drag your mouse up and down
changing only the Y value. Click the mouse or press [Enter] to set the position.

Press your left mouse button inside an active line of text and drag the text to the
desired position. This will change X and Y at the same time. X,Y placement may
also be adjusted using the arrow keys on the keyboard when you are not editing
any other parameter. For arced letters, the XY location is the circle center.
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Optional letter parameters which may not be present in all versions:

~ Inline/Outline - Allows you to manipulate the borders of text and graphics for special
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effects. Inline creates a border a specified distance to the inside of the original
shape and outline creates a border a specified distance to the outside.
The Inline/Outline feature is accessible from the Transform menu as well as by

pressing the [ ~ ] key on the keyboard or clicking on the “~" button on the side
menu bar. If the Inline/Outline option is installed the following five options appear:

Shape with Inline Border
Shape with Qutline Border
Inline Border Only
Outline Border Only

one

Iz a0 o o

a - creates a border inside the text or graphic while retaining the original shape.
b - creates a border outside the text or graphic while retaining the original shape.
¢ and d - creates an inline or outline border only without the original shape.

n — clears the transformation.

These options are effective for decreasing and increasing the weight of a font or
image and creating special borders.

Selecting any of the In/Out line sub-menu options results in the following prompt:

In/Qut Line Offset
0.0 clears the transformation

The offset value refers to the distance between the original shape and the
Inline/Outline border. For example, if .05 is entered as an offset value, the border
is .05 inches from the original shape. The Inline/ Outline parameter retains the
current offset value when a new line is inserted.

For pen plotting, engraving and printing, selecting Inline/Outline options a or b with
Shaded Output turned ON from the Output menu creates a shaded border around
the original image. The original image will not be filled. Selecting the ¢ or d options
will fill the new Inline/Outline image and does not retain the original shape.

Special effects can be achieved by changing the Inline/Outline option while using
two text lines with identical parameters including the actual text or graphics file
selection.

As an example, for multicolor pen plotting, set one line to Shape With Outline and
use a black pen. Set a second line to Inline Only and use a red pen. Turn shading
on for both lines.

To create multiple outlines around the same line of text, copy the original text
several times, and increase the Inline/Outline offset. Repeat the same XY values.

Accessing Inline/Outline while editing a line of text applies the Inline or Outline only
to that text line. The Edit | Group | Edit menu can be used to apply an Inline or
Outline border to multiple text lines.

Special effects can be created by applying several features to the same line of text.
Inline/Outline can be used with Welding and Distortions to create custom effects.
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NOTE: INLINE/OUTLINE HAS NO EFFECT ON SINGLE STROKE FONTS. OPEN SHAPES IN A
GRAPHIC ARE IGNORED.

Lead Line - The Lead Line features is useful in stained glass, sandblast mask, and
router type applications. Where Inline/Outline entries are always positive values,
Lead Line can be a positive or negative number.

For stained glass application the Lead Line compensation is the distance left
between pieces. The Lead Line parameter is always a positive number.

For router applications the tool size is compensated toward the discarded material.
The Lead Line value represents the diameter of the tool size. In the case where
pieces are being cut out and the outside material discarded, the tool size (diameter)
compensation is negative. When cutting holes where things will fit and the inside
material discarded the tool size (diameter) compensation is positive.

Similar to Inline/Outline, Lead Line is an inlining feature but treats all closed shapes
of a graphic without respect to levels of enclosure, thus, each shape is processed
independently of every other shape.

In comparison, the Inline/Outline feature determines the level of each enclosure
before processing. For example, the letter “B”. To make the stroke stronger (to
give it more weight), use the Outline feature. The two holes of the “B” become
smaller while the outside shape becomes larger. This is because the holes are
enclosed in the outside shape. In fact the stroke is heavier than before by two
times the Outline parameter that is set (once, in increasing the outside and also by
diminishing the holes). If the Lead Line feature were used over the same letter “B”.
the letter will appear smaller or bigger (positive or negative value) but the stroke will
be unchanged.

NOTE: A LINE OF TEXT CAN HAVE EITHER THE INLINE/QUTLINE OR LEAD LINE PARAMETER
SET, BUT NOT BOTH.

& Distortions - The Distortion feature allows you to apply over 60 predefined
transformations to text and graphics. Preset Distortions include waves, arcs,
peaks, notches, cylinders, planes, ogees, a large selection of perspectives, and a
globe.

NOTE: DISTORTIONS ARE EXPLAINED IN DETAIL IN THE DISTORTION SUB-MENU SECTION
AS PART OF THE TRANSFORM MENU,

To distort a single line, you must be editing that line. Other lines within the
designated Distortion box will be ignored. Multiple lines Distortion may be applied
by using the Edit | Group | Edit menu.

The Distortion feature can be accessed from the Transform menu or by typing the
[&] key on the keyboard, respectively clicking on the & button on the side menu.

After selecting [&] Distortions, the Status Bar under the menus starts blinking and
then shows instructions on how to set the Distortion Box

Drag Rt mouse to set distortion area; Click Lt mouse to keep same area

Where Rt mouse means you must use the right mouse button to set a new
Distortion box (the same way as if you are zooming). In an existing distortion, if you
want to keep the same Distortion box but edit the distortion parameters or change
the distortion type, you must left click inside of the old box (displayed in green) to
keep the same box area.
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Line Parameters

NOTE: THE BOX MAY BE POSITIONED TO ENCOMPASS ANY OR ALL PORTIONS OF A LINE.
ONLY ONE DISTORTION CAN BE APPLIED TO A LINE OR GROUP OF LINES OF TEXT.

Once the Distortion area is established, the Distortions sub-menu will appear listing
all Distortions available in Stencil-Art. Scroll through the list and double click the
appropriate selection. A preview of how that Distortion applies onto your area will
appear to the right of the list. The blue box shows the area you have selected, the
green grid, outlined in red represents the same area after the Distortion is applied.

To clear the Distortion from a line, select the line, click on the & function, click with
the left mouse button somewhere in the Drawing Area. When the Distortion sub-
menu is up, select Distortion OFF (entry # 0 on the list).

$ Weld - When turned ON, removes overlaps which exist in a single line of text -
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lettering or graphic.

The Weld feature can be accessed either from the Transform menu or by typing
the [$] key on the keyboard or by clicking on the $ button on the side menu. When
activated, you have a choice No/Yes - select the desired option.

To weld an Inline or Outline, apply the /O offset value and select Weld | Yes for
that text line.

To weld or connect script text, the Between Space needs to be a negative value to
cause the letters to overlap slightly. Then choose $ Weld Yes for that text line.

To weld muitiple lines of text, you need to combine the lines into a single graphic
.GNT file. One method is to size the affected lines up to their real size. Turn off
any lines you do not need. Turn OFF your plotter and output as if plotting. This
creates a system file called MYPLOT.PLT in the main Stencil-Art folder. Import this
compounded .PLT file and turn on the weld option when using the .GNT file.

In some cases you can create the compounded image by exporting the lines as an
EPS file (see File | Export). Then-Import the .EPS file to save the new .GNT
graphic. This technique can be used if the lines to be welded do not have
inline/outline, lead line, distortion or welding.

Refer to the Edit | Select Lines menu to see the exact combined width and height of
your lines. These will be the dimensions of the new graphic. See Reports F3 in the
Select Lines sub-menu.

Add a new line of text using the F4 function when text is requested. Select the
newly imported file. Set the Height of the graphic. Using the arrows, register the
graphic on top of the original lines. Then turn off or delete the original lines.

The Export to .PCX Adobe can also be used to compound images and text. This
method erases the area underneath each added text/graphic. Some bitmap editing
can be done as needed to erase or add connections. The Raster/Vector
conversion then creates a welded graphic file. See Technical Notes on Adobe
Streamline.

NOTE: WELDING HAS NO EFFECT ON SINGLE STROKE FONTS. OPEN SHAPES IN A
GRAPHIC ARE IGNORED.




Text Handles

Text Handles

Stencil-Art provides you with two sets of text handles for easy mouse access to the most
often changed line parameters: Height and Edit Length parameters in Auto and Manual
Mode are features of the first text handle set; Italic, Rotation, Between Space and
Width % parameters can be accessed with the second set of text handles. A
combination text handle set is used for arced text.

The text handles surrounding a line indicate that line is currently available for editing.
The line number being edited is displayed in the status line to the right of the # symbol.
Changes made to the Edit Text parameters are only applied to the line being edited.

Click the area of a desired line to select it. The Line # value on the Status line changes
and the first set of handles appears. To toggle between both sets, hold the [Ctri] key
down when clicking inside the line area. For Highway (HWY) fonts, the second set of
handles is not available.

Each time your mouse passes over a handle, a side menu pop-up will hint what line
parameter can be accessed with this particular handle. If the line is not rotated, the
mouse pointer will also show a small icon that corresponds to this line parameter.
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= 2 o o
1 i 1 I
1 ' 1 ]
1 Ll 1 1
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There are two ways to work with handles. The first is to drag the handle with your
mouse left button. The second is to click the handle and use the arrow keys from your
keyboard or move your mouse with no button down. Every movement will change the
activated line parameter one increment at a time. The value will be shown at all times
on the right side of the Status Bar. A box will display the text area until the handle is
released.

If you are dragging the handle, release the mouse left button to accept the changes and
redraw the text line. If arrow keys are used, hit [Enter] or click with the left mouse button
when you are satisfied.

During every session of work with a text handle you can hit [Esc] to return the previous
value of the currently selected parameter.

First text handle set

The line parameters which can be changed with the first handle set are Height and Edit
Length. The icons for these parameters are Windows sizing arrows pointing in the
appropriate direction.

Corner Text Handles - Any corner handle affects the Height of the line in Auto Mode
and provides normal text proportions. The result of using a corner handle is that
the diagonally opposite handle is a stable point and the activated handle will
change the text dimensions away from the stabilized position.

Middle Upper and Lower Text Handles - These two handles affect the Height of the
line in Manual Mode. They will stretch the text by changing only the Height
parameter and retain the Edit Length value of the active line. The stable point is
always the opposite handle.

This handles are not displayed for lines using the Stencil-Art HWY fonts.
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Text Handles

Middle Side Text Handles - These two handles affect the Edit Length of the line. They
will stretch the text by changing the Edit Length parameter while retaining the
Height of the active line. If the Text line is Center Justified, using any of these
handles will stretch the line proportionally away from the center point of the line. In
case of Left or Right Justification the stable point is always the opposite handle.
Both Between Space and Width are adjusted for standard fonts. For the Highway
(HWY) fonts, only between space is adjusted. For graphics only, the Width is
adjusted.

Second text handle set

The line parameters which can be changed with the second handle set are ltalic Angle,
Rotation Angle, Width % and Between Space. The position of the handles depends on
the Line Justification.

& ltalic Text Handles - The ltalic text handles are always the upper corner handles.
Values between -60 and +60 degrees are allowed.

@' Rotation Text Handles - The middle upper and lower text handles always affect

the Rotation Angle Parameter. When the line is Left Justified - the middle left text

handle is also a Handle to Rotate. When the line is Right Justified - the middle right

text handle is a Rotation Handle.

Width Text Handle - The handle that affects the Width % Parameter is in the
middle of the opposite side to the Justification. This handle changes the Edit
Length by increasing or decreasing the Width parameter of the line. If the Text line
is Center Justified, either mid end handle may be used to stretch the line
proportionally away from the center point of the line. For Left or Right Justification,
the stable point is always the opposite handle.

¢ﬂ]¢ Between Space Text Handle - The handle that affects the Between Space
Parameter is always the lower corner opposite to the Justification point. This
handle changes the Edit Length by increasing or decreasing the Between Space
parameter. If the Text line is Center Justified, both lower corners are Between
Space handles. Using them will stretch the line proportionally away from the center
point. For Left or Right Justification, the stable point is always the opposite handle.
A Between space text handle has no meaning for a single character line or a
graphic line.

Text handle set for arced lines

Stencil-Art provides you with a combination of both handle sets for arced text. The
parameters that can be are Height in Auto and Manual Mode, Edit Length, Radius of
Arc, Rotation Angle, Width % and Between Space.

The difference in this set is the Radius Text Handle. Use this handle when you need to
change the curvature but not the placement of the text.
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Text Handles

Height Manual

Radius B 'g Height Auto
Width 5 | B EditLength
Rotation .
BetweenSpace B B EditLength

Looking at the example of handle locations, the Rotation handle is the stable point of
text placement and the justification point (X and Y parameters) will be changed when
you use the Radius handle. The X, Y parameters may be out of bounds.

NOTE: THE RADIUS HANDLE, WHICH DOES NOT CHANGE THE TEXT PLACEMENT, IS NOT
THE SAME AS THE RADIUS [R] KEYBOARD AND SIDE MENU FUNCTION.

Where the Radius handle will maintain the text placement and change the radius by
moving the justification (X,Y center) point, the keyboard and side menu radius [R]
function will maintain the radius by using the justification point as a stabile point and will
move the text placement to the specified radius. The radius must be non-zero to enable
use of the Radius Handle.
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Standard Editing Keys

Line Controi

[Esc] or [\] - Saves the parameters of the present line and initiates a new line of text
which has most of the same parameter values (see [=] and Insert Line functions).

[<] and [>] - Select these symbols to move backward or forward one line number in the
sign file. The text handles will move to the new line and the menu display will
change to the parameters of this line. If the newly selected line is hidden you will
be prompted to display the line. If you choose not to display all lines, you may still
edit them from the Edit Text sub-menu. A line does not need to be graphically
displayed in order to be edited.

[Ctrl <] and [Ctrl >] - Select these symbols to move backward or forward between
selected lines only. Hidden lines will be skipped. The text handles will move to the
new line and the menu display will change to the parameters of this line.

[Ctrl H] - Hides the active line.
[Del] - Deletes the active line.

[PgUp], [PgDn] - These keys set the amount of incremental movement of the arrow
keys and the mouse. The current value is displayed in the status line immediately
after the Y parameter . This value toggles from .001 to 10 in both inches and
centimeters. If you would like to select a value different than .001 ,-01,.1,.5,1, 2
and 10, you must to click on the present value over the status bar or go to Cursor
Movement in the View menu.

Arrow Keys - The arrow keys may be used to move a line of text by one increment of
movement at a time.

[=] - Line Spacing controls the automatic spacing between lines when inserting new
lines of text. It also determines the increment of movement of the Up Line [Ctrl + T]
and Down Line [Ctrl + {] entries.

Line Spacing value can be set as a default. A positive value is normal and lines of
text are placed one bellow another. A negative value can be entered for Line
Spacing which allows you to place text from the bottom, upward. A zero value
entered for Line Spacing would force each line of text to be placed on top of the
previous line. In this case the New Line Down [N] feature could be used to place
the text line.

A new line of text will be placed above or below the previous line by the amount
specified by [=] Line Spacing. Up and down directions are affected by the Rotation
Angle.

[Ctrl + T] - Up Line entry moves text up by the amount specified in the [=] Line
Spacing entry.

[Ctrl + 1] - Down Line entry moves text down by the amount specified in the [=] Line
Spacing entry.

[N] - New Line Down moves the current line of text down by 1.5 times the present
Height value.
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Standard Editing Keys

NOTE: THE ABOVE 4 FEATURES AFFECT ONLY THE “Y” PARAMETER OF THE LINES OF
YOUR SIGN. UP LINE, DOWN LINE AND NEW LINE DOWN CAN CAUSE THE Y-PLACEMENT
VALUE TO EXCEED THE SIGN BOUNDARIES.

[O] - Output Regeneration will refresh the entire drawing area.

[Q] - Quick Redraw refreshes the active line only.

Line Parameter Editing

Arrow Keys - If you are editing the numeric or text value of a parameter, the arrow
keys function is to change the cursor position within keying display.

[Tab] and [Shift][Tab] - Select these keys to scroll between the available fields of any
pulled down sub-menu.

[DEL] - Deletes character above cursor.
[BS] - Deletes character in front of cursor.

[INS] - Toggles between overstrike mode and insert mode. A block cursor indicates the
overstrike mode while an straight line curser shows insert mode.

[Home] - Places the cursor at the beginning of the entry.
[End] - Places the cursor at the end of the entry.

[Enter] - Confirmation. Whenever the mouse pointer is hidden, [Enter] or a click with
the left mouse button will produce the same result.

[Esc] - When editing parameter values, [ESC] retains the previous entry.
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Extended Character Set

These characters may be included as text using the [Alt] key and a 4 digit key pad entry.
Some fonts may not include this entire set of characters.

Jf

0128

jf

0131

44

0132

A4

0133

T

0134

I

0135

~

0136

Y00

0137

E

0140

7

0141

/

0144

(14

22

0148

0149

0150

A

0151

0152

™

4

0156

/

0157

0160

@)
0164

0166

0167

0168

0171

0172

0173

0176
3, |

[
0180

0182

0183

)
0184
h)

»

0187

72

0189
r

A

0192

A

0196
~

0198

¢

0199

B

0200

s

0203

[

0205
!

D

0208

O

0212

0214

X
0215

%]

0216

U

0219

Y

0221

-

d
0224

a

0228

&L
0230

¢

0231

N\

c
0232

Cc
0235

0237

d

0240

n
0241

0242

0243

~

O

0244

0245

O
0246

0247

%)
0248

0249

0250

et

u
0251

th el

3

" The symbol f means that there is no letter assigned to this code.
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International Symbols

A symbol or multiple symbols may be used by selecting one of
the pictogram fonts and entering the corresponding letter as t-ext.

'SGI77751 - International Symbols
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INTERNATIONAL SYMBOLS
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Font Manager

Font Manager rebuilds and controls font directories in Stencil-Art. It can be accessed
from the Font Selection window by pressing the Font Manager button.

The Font Manager screen appears and all available options are listed as follows:

Build Builds a font list, so all fonts from a chosen directory are
available in Stencil-Art.

Create Folder Creates a new font directory.

Add Fonts Adds new fonts to an existing directory.

Remove Fonts Removes fonts from the Letter Art font list.

List Helps you view and print font lists from different directories.

Exit

Exits the program.

Build Font Directory

Select the Build Font Directory feature by pressing the Build button. At the bottom
of the screen a pop-up text displays:

“Select the Path to Build the Font Table
and click on the Build button”.

To locate a font directory, use the Drive list to select a drive and double-click the
desired directory on the Directory list.

‘Confirm the Active Font Directory and click on the Build button.

You will see the list of all Stencil-Art fonts being built. A progress bar is displayed
under the font list. After the list is built, the program returns to the Font Manager
screen.

Create folder

Press the Create Folder button to initiate this feature. Locate the folder in which
you want to create a new directory using the Drive and Directory list.

Confirm the Active Font Directory path and click on the Create Folder button.

You will be asked to name the new folder - type the name and click the OK button.
The program returns to the Font Manager screen.

Add Fonts

Select the Add Fonts button to initiate the feature. At the bottom of the screen the
pop-up text displays:

“Select the source path and click -
the OK button”.

To locate the source path, use the Drive list to select a drive and double-click the
desired directory on the Directory list.

Confirm the Source Font Directory and click the OK button.
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The guiding text displays:

“Select the Path of the target Font Directory
and click the OK button”.

Use the Drive list to select a drive and double-click the target directory on the
Directory list.

Confirm the Target Font Directory and click the OK button.

A list of all Stencil-Art fonts from the source directory will be displayed. You have
two options.

1. To add all fonts from the source to the target folder (use Add All Fonts button).

2. To add one or more fonts, highlight the font and click on the Add Font button
(Double-clicking the font from the list will have the same result). Repeat this
process for each font wanted. When done, click on the Back button to return to the
main screen. -

If a font already exists in the target directory, you will be prompted to:
Automatically update All fonts?
Answer Yes to update all duplicating fonts without further confirmation. To confirm
each font update, answer No. Cancel to escape to the Font Manager screen.
Remove Fonts
Select the Remove Fonts button. The guiding text displays:

“Select a Font Directory and click
on the Start button”.

Use the Drive list to select a drive and double-click -the desired directory on the
Directory list.

Confirm the Active Font Directory and click on the Start button.
The guiding text displays:

“To remove a font, select a font from the list
and click the Remove button”.

Point with the mouse to a font, so it becomes highlighted, and click on the Remove
button (Double-clicking the font from the list will have the same result). Repeat the
above for each deletion. When done, click on the Back button to return to the Font
Manager screen.

NOTE: WHEN YOU REMOVE FONTS FROM THE LIST THEY ARE NOT DELETED FROM THE
DIRECTORY SO YOU CAN ADD THEM BACK AS NEEDED.

List

Click on the List button and a pop-up menu with three options appears.

List by File Name
List by Font Name
Selected Fonts
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Ali three options let you view and print alphabetically ordered font lists from different
directories. All lists are dated and the path name is included. Lists can help you
organize your computer or simply memorize the fonts.

List by File Name - Creates a list of a chosen font directory. The list will be sorted by
the external file name. If you print this list, it will help you when working with the
File Manager. This gives you a way to connect the font name that you know from
Stencil-Art with the external file name.

To access List by File Name, click on the List button and select the List by File
Name feature. The guiding text displays:

“Select a Font directory and click the View button”.

Use the Drive list to select a drive and double-click the desired directory on the
Directory list. Active Font Directory should display the correct path.

Click the View button.

A list of all Stencil-Art fonts from the chosen directory will be displayed. They will
be in external file name order, the same order as if you were working with the
Windows File Manager.

The guiding text shows:
“Select the Print button to output the list”.
Make sure your DEFAULT printer is ready and click the Print button.

If you want to save this list on a text file, select the Save the List option and click
the Print button. The result will be in the Stencil-Art main directory in
‘FontFile. TXT" file.

List:by Font Name - Creates a list of a chosen font directory. The list will be sorted by
internal font name. It can help you organize your font disks and directories.

To access List by Font Name, click on the List button and select the List by Font
Name feature. The guiding text displays:

“Select a Font directory and click the View button”.

Use the Drive list to select a drive and double-click the target directory on the
Directory list. Active Font Directory should display the correct path.

Click the View button.

A list of all Stencil-Art fonts from the chosen directory will be displayed. They will
be in alphabetical order by their internal font names.

The guiding text shows:
“Select the Print button to output the list”.
Make sure your DEFAULT printer is ready and click the Print button.

If you want to save this list on a text file, select the Save the List option and click
the Print button. The result will be in the Stencil-Art main directory in
“FontName. TXT" file.

Selected Fonts - Displays the Stencil-Art Font Table of a chosen font directory. This is
exactly the list that you access in Stencil-Art if you are selecting fonts.
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To access Selected Fonts, click on the List button and select the Selected Fonts
feature. The guiding text displays:

“Select a Font directory and click the View button”.

Use the Drive list to select a drive and double-click the target directory on the
Directory list. Active Font Directory should display the correct path.

Click the View button.

A list of the available Stencil-Art fonts from the chosen directory will be displayed.
They will be in alphabetical order by their internal font name.

The guiding text shows:
“Select the Print button to output the list”.
Make sure your DEFAULT printer is ready and click the Print button.

If you want to save this list on a text file, select the Save the List option and click
the Print button. The result will be in the Stencil-Art main directory in
“FontTABL.TXT" file.

Hint: When you start a feature always look at the pop-up text in the bottom left comer, it
will guide you in the process.

NOTE: IF YOU CLICK ON THE BACK BUTTON AT ANY POINT, IT WILL RETURN YOU TO THE
FONT MANAGER SCREEN. PRESSING [ESC] OR CLICKING THE ‘FONT +/-° ICON HAS THE
SAME EFFECT.
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Technical Notes on Adobe Streamline

Scanning

Open Adobe Streamline 4.0. Choose File | Acquire | Select TWAIN_32 Source...
menu. Select a plug-in filter scanning program from the menu. Go to the File | Acquire |
TWAIN_32... menu to scan and preview a good copy of your drawing. Set options for
the selected plug-in filter, including:

1. Correct the Brightness if necessary until you have a satisfying black and white
drawing.

2. Increase the scanning resolution to 450 dots per inch (600% for 75 DPI).

3. Set the area to be included in the high resolution final scan area.

4. Make a FINAL scan of the artwork to be used in Bit Map Editing.

Bitmap Editing

Editing of the scanned artwork pixel image may be needed. Lines may need to be
trimmed or extended. Thick intersections may need thinning. Filling holes in the ink
lines may be required. The Raster Conversion automatic despeckling will remove some
noise. Experience will quickly teach what can be expected.

There are 5 main tools for editing the bit map image:

The marquee tool
Lets you select rectangular area for deleting or conversion processing.

The lasso tool
Lets you outline areas for deleting or converting to vector image.

The pencil tool
Lets you paint freehand lines in the color displayed in the toolbox swatch.

The line tool
Lets you paint constrained or unconstrained straight lines.

The eraser tool
Lets you change the color values of pixels (“erase” them) to white.

The eyedropper tool

Lets you select a color from a bitmap image and displays a color swatch.
By double-clicking any of the pencil, line or eraser tools you can change their thickness
option.

Raster Conversion Setup
Open the Conversion Setup sub-menu from the Options.

Outline Tracing Conversion Setup

If you have scanned a filled in image, select only the Outline option in the Conversion
Method section. The rest of the options vary depending on the quality of the original
artwork (Accuracy section) and the curve complexity of the drawing itself (Path Options
section). '
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Line Art Conversion Setup

If you have scanned a line art image or any other child's coloring book type picture,
select the first two conversion methods Outline and Centerline and the second art option
Separate Shapes.

1. Setting the Noise Suppression value to around 40-44 will help despeckle the

conversion.

2. Increasing the Line Thinning value to around 15 usually produces better line art
work.

3. A Tolerance value around 1.5 will keep vectorization fairly tight (close) to the pixel
artwork.

For more information refer to the Adobe Streamline Online Help.

Conversion to Vector Image
Select File | Convert to initiate the Raster to Vector conversion.

After completing the conversion, press Ctrl-A (Select All), then click on the View | Show
Info menu. Note the number of Paths that were converted. If you are doing line art
work, the number of Paths in the report corresponds to the separate color pieces.

Tip
Select the Art and Raster and Preview display options and take a close look at the
conversion results.
1. The lines should all be black and very distinct. Grey sections indicate
disconnected artwork. Use the raster tools to draw and connect lines.
2. Are all parts that are supposed to be separate, really separate? - The raster may
need more cleaning.
3. Is there a lot of noise? - The Noise parameter may have been set too low -
increase it.
4. For lines that do not seem to convert, draw a small cross line midway along the
unconverted path. The cross line causes Streamline to create an extra node to
help with path constructions. The cross line will not cause any unwanted artwork.

Switch to Raster display option and do the conversion again.

Vector Manipulation

Minimum Smoothing of the Paths

Select the Art &Raster and Artwork display options and then Edit | Select All. From the
bottom of the Edit menu, select the Smooth Paths sub-menu. This is a very helpful first
step in the vector editing process. It eliminates a significant number of data points,
straightening out lines and combining arcs. It is important to keep the walls of the
separate pieces together, so you do not want to do toc much smoothing. Normally, a
minimum smoothing, applied only ONCE will do the job. Zooming in and panning the
entire graphic will let you see the effects. With line art work, if smoothing causes the

64




Adobe Streamline - Scanning

vector paths to start separating from the original pixel artwork, use Undo (Ctri+2) to
back up.

Often some paths need more smoothing then others. Click outside all paths so none of
them is selected. You can then click on an individual path and do more smoothing on it
only. You can also select multiple paths by holding the Shift key down when pointing to
the paths with the mouse.

Vector Editing Tools
Add-anchor-point and Delete-anchor-point tools

To add an anchor point:
1. Select one or more paths. The existing anchor points become visible when you

select a path.
2. Select the add-anchor-point tool.
3. Click on a path segment where you want to add an anchor point.

To delete one or more anchor points:
Select the delete-anchor-point tool.

» To delete a single anchor point, click the anchor point you want to delete. You
can repeat this step to remove more anchor points one at a time. You may
want to do this to see the path that results after deleting each anchor point.

* To delete multiple anchor points, use the delete-anchor-point tool to place a box
around the anchor points you want to delete.

Adjust-Line tool

Select the adjust-line tool. The pointer becomes a cross hair when it is inside the
“image area.

'5,'.1 . To move an anchor point of a straight line segment, click an anchor point and
“drag.

2. To adjust a straight line segment, click anywhere on a straight line segment
between anchor points and drag. The segment’s anchor points are duplicated and
move along with the segment. New segments connect the original anchor points
and the new anchor points of the repositioned segment. Holding the Shift key while
dragging a straight line segment will constrain the segment to be horizontal, vertical,
or at a 45-degree angle, which ever is closest to the segment’s current position.

3. To convert a curved segment to a straight line, click a curved segment and it will
become a straight line

Adjust-Curve tool

Select the adjust-curve tool. The pointer becomes a cross hair when you point
inside the image area.

1. To move an anchor point on a curved segment, select anchor point and drag.

2. To adjust a curved segment, click anywhere on a curved segment between
anchor points and drag. The segment’s anchor points remain in place as the
segment is reshaped as a Bezier curve. Hold Shift as you click and drag to
constrain the segment to a circular arc.

3. To convert a straight line segment to a curve, click on a straight segment.
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4. To adjust a wave segment,
e Select the add-anchor-point tool and click on the wave at the point of the curvature
inflection.

o Select the adjust-curve tool. Adjust both arcs as explained above.

o Click the delete-anchor-point tool and remove the added point from step 1.

Saving the Vector Image File

Select the File | Save Art As ... menu. Chose Save As Type “Illustrator EPS (.eps)”.
Locate the directory where you want to keep your vector files. Give a name and
confirm. Remember the directory where you save the .EPS files for retrieving the files in
Stencil-Art.

NOTE: It may be necessary to touch up the scanned image after seeing how the
saved file behaves in the Stencil-Art Program. DO NOT CLOSE THE SCANNING
PROGRAM AT THIS TIME - JUST MINIMIZE IT!

Tip

Use the application program immediately after the Raster /\Vector conversion. Select
the vector file and Burst the graphic. Then, display the pieces with Wire Frame turned
off. If there are pieces that are not solid shaded (in filled) they need to be bitmap edited.
This editing can be done at the same time as other more obvious bitmap editing, vector
thinning and vector manipulation.

Using Graphic Files in the Application Program
Open the Stencil-Art application program.

importing the Vector Image and Saving the .GNT Graphic File

The first step is to add the vector file(s) from the scanning Raster to Vector conversion
to your permanent library. Click on the File | Import menu and choose the “EPS” file
format. Locate the directory of the .EPS vector image file(s) saved in the Raster/Vector
Conversion. Highlight the file and double-click it to display the graphic. Then click on
“the “Save” button. Assign a name and description to the .GNT file and locate the
directory of the permanent library. Click on the “Save” button again. Repeat this step
for each file created in the scanning process.

Bringing the .GNT to the System
In a new sign, select T for text and press the [F4] key on the keyboard. Select the

graphic file and confirm.
Smoothing the .GNT in ICU Mode

It is possible that the Raster/Vector conversion in Streamline can be improved and
curves can be smoothed to perfection. The nature of the Center Line algorithm in the
raster/vector conversion is to try to find the middle pixels alongside each raster stroke.
At the raster stroke junctions this is not always the most aesthetically pleasant solution.

The reasons for this might be several:
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-  Different thickness of raster strokes, or even verses odd pixel width wherein it's
unclear which one is the middle pixel.

- In Streamline, all drawings are two-dimensional and the program does not recognize
depth.

If the graphic is going to be part of a stained glass application, the small problems
around the curve junctions can be easily fixed when the lead is applied. For sand
blasting, sign making and other applications you may want to make sure that curves and
curve junctions are smoothed.

Look in Transform | ICU Mode menu help for Curve Smoothing.

Tip: If you need to create visual depth layers in your graphic, start smoothing the top
layer and work your way down.

Bursting an Image

Newly created graphic files can be burst and spot colored. If you need to spot color an
old .GNT file there are two ways to prepare it for bursting:

1. If you have the original .EPS file of the same graphic, just re-import it
(recommended) because it will keep the curve information. However, re-importing
may not work if the .EPS was created incorrectly. When using a .GNT graphic, set
the Shade value for this line to 0.002. Turn the Wire Frame option Off (View menu).
If the graphic has parts that will not shade then use the following method.

2. Start a new sign. Bring up the .GNT file in Stencil-Art. Resize it appropriately for the
job. Create a .PLT file by re-directing the output of the plotter to DISK instead the
regular parallel or communicational port (i.e. Output for Plotter-1, Configuration tab).
Switch to the Output tab. Resize the panel size so the whole graphic fits in one
panel. Click on the Output Lines button and name the .PLT file when prompted.
Remember the directory where you save the .PLT file for retrieving the files in the
Import function. Plotter output files are highly filtered to connect segments into
closed paths.

Open the File | Import menu. Change the file type to PLT. Adjust the directory path
to where you saved your .PLT file. Import and save the .PLT file into a permanent
graphic file (.GNT).

Sizing the Image, Stretching And Placing

Drag the graphic to its place in the sign. Size it and stretch it to its real dimensions
before bursting.

Bursting the Image

Select the Transformation | Burst Graphic menu. The burst graphic feature will ungroup
the image so that each piece in the picture can be individually edited. See Spot Color
and Color Layer Separation.

Select the Edit | Group | Edit or the Edit | Select Lines menu. The burst graphic file
name appears in every line. The first and last lines of a burst graphic have no number
in front of the file name and will not be actively selected by default. All other lines will
have a piece number in front of the graphic file name. The piece numbers correspond
to numbers that will appear in color separations and printed enumerated maps.
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The last line of a burst graphic file is a repeat of the first line. These two lines will have
their Shade Density set to zero and neither will be actively selected at this time. When
shading is turned on or when the menu View | Wire Frame | Off is selected, these lines
will not shade (in-fill). Selecting either line will show all parts as if they were a single
entity.

NOTE: If there are graphic parts that do not shade, it means that there were gaps
in the bit map. Before returning to bitmap editing and conversion, all lines burst
from the graphic file must be deleted. Select Edit | Group | Delete and remove the
entire set of graphics lines showing the same file name as the unclosed pieces.
Return to the Bitmap Editing to close gaps that prevent closure of pieces. After
remaking the vector .EPS image file, return to the application program, import the
new .EPS file to the graphic library, and add the new file back into the job by
pressing the Esc-key | F4 key and selecting the revised vector file. Then repeat
Sizing the Image, Stretching and Placing.

Spot Color
Select any piece by clicking inside the shape. If necessary continue clicking until you

see a rectangle surrounding it. Select C for Color and assign a color. Using Wire
Frame | Off lets you see each area as you assign colors.

Color Layer Separation

Select the Edit | Select Lines menu. Click on the Clear All button. Be sure the Toggle
or On option is selected. Click on the desired color in the first column of the Line List.
All lines having the color will become selected. If you need to tum off some lines with
this color, select the Off or Toggle option and click on the third column of the Line List at
the appropriate row. Confirming the selection with OK will display the chosen lines.
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STENCIL-ART TUTORIAL

Level One - This exercise teaches you how to put your name and address together as
a three line sign and output to your plotter.

Level Two - Level Two will show you how to change the layout of the original three
lines by using additional menu selections. You will learn to arc and italicize lines and
more.

Level Three - The Level Three Tutorial is the most challenging of the exercises and
will help you learn some of the group operations.

Level Four - The Level Four Tutorial will teach you how to add elements to your
permanent graphic library and how to use them in Stencil-Art.

LEVEL ONE TUTORIAL

This tutorial is your key to the exciting world of computerized sign making. The
exercises offer you the skills necessary to create a sign and will show you how easy it is
to use Stencil-Art. In this tutorial, the word sign is used to mean a small engraved
badge, a full sized street banner, pin striping for your car, graphics for sand blasting,
designs for stained glass windows or just lettered signs. Working with text is the easiest
way to learn the use the program. Then, just think of a graphic as being a one-letter
font.

Once you make a simple sign, you will get a glimpse of the full capacity of the program.
Designed to make the learning process fun and rewarding, this tutorial will use
elementary techniques to help you become familiar with the program menus.
Remember that the mouse and keyboard can both be used and one may be faster or
easier in some cases. It is your choice. Because the keywords of the program are
closely related to words you will use to think about working with text and graphics, try
saying the key and the keyword each time you access the buttons on the right side of
the screen. Say them repeatedly until you can say the alphabet in order and the
keyword related to each letter. Learn the English alphabet and you will know the
program. So let’s start with the basics.

Level One is an exercise that teaches you how to put your name and address together
as a three line sign and output to your plotter. When you finish creating the three lines,

your text will look like this:
=
&N

(QJC@AN JONSIE
10457 W, ©th St.

Coreoma, CAY

Tutorial -- 1




Stencil-Art Tutorial

Follow the guidelines and hints found throughout the tutorial. These suggestions coach
you in the functions of menu selections, including the sizing and spacing of your first
sign. We assume the program is installed and the icon is on the screen. So, double
click the Stencil-Art icon. The Symbol Graphics logo briefly appears on the screen,
followed immediately by the main display screen with the Stencil-Art menus. Keystrokes
are enclosed in brackets. Just type the key such as T for [T]. Let's begin.

Display Screen

From the main display screen you can access any of the Stencil-Art menus. However,
Some menus are blocked until a sign is in progress. When a sign is open, select a
menu by:

Clicking on the menu label with your left mouse button;

Press and release the [Alt] key (right or left from the [Space] bar). The word “File” will
be highlighted at the beginning of the menu bar. Then type the underlined letter of the
desired menu or just press the [Tab] key until reaching it and press the [Enter] key.

The menu will appear on the screen listing all features possible for selection.

NOTE: A SIGN MUST BE IN PROGRESS IN ORDER TO ACCESS MOST OF THE MENUS

FEATURES.
When you first start Stencil-Art, the title bar of the main window (above the menus)
shows “Text Editor: UNTITLED” and the status bar (under the menus) shows “Default
settings”. On the right side of the main screen you can see a set of buttons, each
labeled with a letter for changing the text parameters of the present line. As you can
see, all of the letters are dimmed except the [T]. This reminds us to enter text to initiate
a new sign. All parameters in the side bar become available once text is entered.

Access the feature T. The text entry box is on the screen waiting for input:

Text/ Tag File F3 / Graphic Files F4/ Bridge F5

Text can be alpha strings, external text files, permanent library graphics or temporary
bridged graphic file.

Type in your full name, i.e. Joan Jonson. Press [Enter].

Your name is drawn on the screen.

Extended Characters - To use the available European letters for Text entries, refer to
the Extended Character Set pages included at the end of the Users Guide. Fonts may
ASCII or Windows extended character set. For each character needed, hold the [Alt]
key, enter the appropriate four digit keypad numbers, then release the [Alt] key. For
instance, holding [Alt] while entering [0191] on the keypad produces the Spanish
question mark [¢ ] character.

Look at the side menu after entering text, all of the parameter buttons are available.
Move your mouse over each side menu button and you will see a pop-up label showing
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Level One

the full title of the line parameter. The button letter and parameter are closely matched,
.e.[T] was for text, [C] for color, [D] drawing size. Note that we will use capital letters
but both upper and lower case keyboard entries are treated the same. When text is
shown between brackets, type on the letters not the brackets.

Note for Stencil-Art Highway users: This tutorial is meant to teach you to manipulate
text appropriately for the sign making industry. Some of the features listed below
behave differently with the Stencil-Art HWY fonts. After you are through with this
tutorial, refer to the Line Parameters chapter in the Users Guide for details.

To continue with this tutorial, please press F for Font selection and double click on the
following font name from the list:

SGI71102 - HELVETICA MEDIUM Click on the OK button after sampling a few
letters.

Height - There are three ways to change the [H] Height of text from the main screen.

These three approaches have something in common - a broken line box will dynamically
show the changes and the current value of the Height parameter will be displayed on the
right side of the status bar.

Using the mouse. Looking at your name on the screen, the 8 small boxes surrounding
the text are referred to as handles. The comer handles are used for Height entries.
Locate your mouse cursor inside a comner handle. Hold down your left mouse button
and drag the handle. As you can see, we have a proportional change of Height and [E]
Edit length for undistorted text. Release the button when ready. If you prefer, you can
click the handle, move the mouse and click again when ready.

Using keyboard entry. Type [H] when no menu is pulled down and type a value for the
Height parameter. Or use the arrow keys to set the correct value. Press [Enter] to
confirm the changes.

Using the arrow keys. Click on a corner handle and adjust the value of the Height
parameter with the arrow keys. When ready, hit [Enter] or click with the mouse.

The Edit | Text sub-menu lets you see several other parameters which may be affected
by height and will also let you type in new height values. Let's practice changing height
through the Edit | Text menu.

Edit | Text sub-menu

Pull down the Edit menu, click on Text or type [T] to display the sub-menu. From here
you can access most of the parameters which affect the final appearance of a single line
of text. Note the alphabetical correspondence between most menu selections and
menu words e.g., [F] for Font. This design was chosen to help you commit to memory
most functions of the sub-menu. All parameters from the Edit | Text menu are also
available when no menu is pulled down. The parameters can be accessed by keyboard
entry or by using a mouse on the side menu bar.
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The field next to the label Height shows 1.000. Click with the mouse inside this field.
The current value becomes highlighted. This means that typing directly over the
highlight will replace the content of the present field. For your name, let's set the upper
case Height to .9 inches. Type .9 and press [Enter]

The size of all lower case letters, numbers and special characters will be proportional to
the uppercase height. Stencil-Art allows lettering from as small .01 to unlimited height.
A Height value must be larger than 0.000 (zero).

The changes that you make with the Edit Text sub-menu pulled down are not graphically
displayed until you close the Edit menu. Click the OK button with your mouse or type

[O]. The menu will disappear and changes will be regenerated on the screen. It's time
to continue revising your sign.

View | Sign Layout sub-menu

The Sign Layout sub-menu allows you to control parameters that affect the size and
design of your sign. You can also drop down this sub-menu by typing D (Drawing Size)
or clicking on the D button on the side menu. Let's establish the dimensions of your
sign.

Drawing Size - Drawing Size refers to the Width and Height of your sign and these
dimensions must be large enough to encompass all lines of text. The Drawing Size
affects the display on the screen by showing a proportional representation of the sign
dimensions.

Select D. The Sign Layout sub-menu appears and you can enter new dimensions for
Width (X dimension) and Height (Y dimension) of your sign. To help you set the size,
think of your drawing as a piece of paper. For this tutorial, enter the dimensions for a
piece of paper laid sideways measuring 10.5"x8.5".

Enter W 10.5, H 8.5. Click the OK button with your mouse or type O.

For many printers, the Drawing Size is the same as the Panel Size. See "Panel Size"
for additional information. For plotters, the Drawing Size is unlimited. If the drawing
size exceeds the Panel Size in either dimension, the sign will be output in pieces
(panels). Printers can also panel with multiple pages.

View | Grid / System Units sub-menu

From the view menu, you can turn on and off the Wire-Frame. This will fill the lettering
solid.

From the View menu, you may also set up a Grid for sizing and spacing purposes.
Select View again and locate [G] Grid on the menu.

Grid - The Grid enables you to place your text accurately within the limits of your sign.
It is a series of incremental marks that provide a visual reference of placement, size and

scale to be produced by your plotter or printer.
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To change the Grid display, pull down the View menu and select G. The Grid Size value
by defaultis 0. Grid is OFF when Stencil-Art starts. To turn it ON, enter a positive
number representing the space between the Grid marks. Grid values may be any value
including decimal fractions. The larger the Grid value, the larger the Grid pattern will be
to accommodate larger display layouts. Try different Grid value entries to see how the
grid sizes vary. A value of O or less turns the Grid OFF.

NOTE: IF YOU ENTER A GRID VALUE THAT WILL PRODUCE A LOT OF GRID MARKS, THE
GRID WILL NOT BE SHOWN BEFORE YOU ZOOM IN.

To continue the tutorial, enter a grid of 1 and click the OK button with your mouse or
type O. At this point in the lesson, your name should appear in the lower left corner of
the Grid, beginning at the X=1.000, Y=1.000 intersection.

Let's learn more about the X and Y values shown on the status bar at the top.

Y Location - The Y value is the location of the text on the vertical (height) axis while X
is the horizontal (width) location. Locate the X,Y placement of the present text line.
Experiment with moving the text to a new Y Location. With the NUM LOCK key off,
press the up or down arrow keys on your keyboard and notice how the Y value at the
top of the screen changes. If you prefer using a mouse, place the mouse inside the text
line and drag the text box with the left mouse button down to a new position. The text
itself will not move until you release the left button.

T_e'xt can also be moved within the grid by entering different X,Y coordinate values.
Using this method, try moving your text position up the screen vertically: Select Y. On
the right side of the status bar Stencil-Art shows the current Y value: Y=1.000

Enter different values for Y to see the text move up and down. Larger numbers move
the text box up, smaller numbers move the text box down. Negative numbers and
numbers greater than the Height of the Drawing Size will cause the text to disappear
partially or completely off the screen.

[PgUp], [PgDn] - These keys set the amount of incremental movement of the arrow
keys and the mouse when they are used to place text or change parameters. The
current incremental value is displayed in the middle of the status line, immediately after
the Y parameter. It is called Step. This value toggles from .001 to 10 in both inches
and centimeters. If you would like to select a value different than .001,.01,.1,.5, 1, 2 and
10. you can click over the present value in the status bar or go to Cursor Movement in
the View menu. The adjustable value lets you make very large or small movements with
a single arrow keystroke or mouse move. Small movements may be helpful in precise
placement of text.

X Location - Now try moving the text horizontally (left and right) by making a keyboard
entry for the [X] location. The process is similar to vertical movement. The status bar
shows the current X value: X=1.000.
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Since the X location is the horizontal position of the text, you can move the text right or
left. When you enter a larger number, the text box moves to the right. When you enter
a smaller number, the text box moves to the left. Try entering different numbers to set
different X location values. Don't forget that you can also use the arrow keys or the
mouse to move the text box along the X axis. You can also click on the X in the status
line thus allowing mouse movement left and right to change the X value without affecting
the Y value. Hit [Enter] when you are ready.

When you are done experimenting, enter a Y location of 4.5 inches and an X location of
5.5 inches. This positions your name for the remainder of this tutorial. Notice that your
name starts in the middle of the screen and may disappear off to the right. This means
the text is exceeding the boundaries of the Drawing Size. Notice also that your line is
completely left from the point X=5.5, Y=4.5 this means that the text is currently left
justified. Let's justify the text so that it's centered in the middle of your sign.

Justification - Justification [J] refers to the placement of text at the X,Y location. You
can place text by its beginning, middle or ending point at the X,Y location. Locate J
Justification in the sidebar menu or the Edit | Text sub-menu. Notice that there are three
options:

Left
Center
Right

When text is Left justified, the text X,Y position is at the Left end of the text base line.
When text is Center justified, the text X,Y position is at the Center of the text base line.
When text is Right justified, the text X,Y position is at the Right end of the text base line.
Try all three justification options, so that you understand how they change the position of
the text

When you are ready to continue the tutorial, set J Justify to Center.

F1 Help - When you select [F1] from any of the Stencil-Art menus, a brief definition of
each menu selection is listed on the screen. To find a particular entry item click the
green word and more detailed help will be displayed. You can scroll through the list of
definitions using the Up, Down arrow keys. The [PgUp] / [PgDn] keys can be used to
scroll a page at a time through the list.

Try selecting F1 with the Edit | Text sub-menu displayed and locate the definition for T
Text to see how this works. The Help function can greatly increase how fast you learn
Stencil-Art but you are urged to continue the tutorial for many of the side notes and
subtleties of using the program.
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Edit Length - The [E] Edit Length is the measurement of your text from starting point
to ending point.. The Edit Length is automatically computed from the text words you
select. You can also force your text to a designated length, regardless of how many
letters make up your line of text.

This value may be adjusted and set to whatever length necessary. If you enter a
number that is larger or smaller than the computed Edit Length, Stencil-Art will extend or
condense the text string to the requested Edit Length. For the tutorial, you will specify
an Edit length of 8". Here's how: Using your mouse, keyboard, or the Edit menu, locate
and select [E]. Stencil-Art displays the Edit Length entry box:

Enter 8.0 as the Edit Length for your name. A value can be entered by simply typing the
required value on your keyboard. Remember to press [Enter] at the end.

The text handles that allow Edit Length changes are located on both sides at level %4 of
the Height of the text string. After changing Edit Length to 8.0, notice that Stencil-Art
has either stretched out the letters and Between Space or pushed them together
depending on the original length of your name.

Now you have learned everything you need to know to draw your name on one line with
Stencil-Art. It's time to Output your name to the plotter so you can prove to yourself just
how quickly and easily you did this and what impressive results it brings.

Output menu

Assuming you are running Stencil-Art for the first time, we have to set the configuration
for your plotter. Select the Output menu. Plotter-1 is the active device. Scroll the list
with all plotters supported by Stencil-Art until you find the name of your device. Click the
OK button.

All parameters that affect the output to your plotter are controlled from the Qutput menu.
Let's learn how to output directly to your plotter:

Device - Select the appropriate output production device. To change the device to a
plotter: Select Plotter-1. The title bar of the menu changes to the plotter name. The
port to which the output is configured is displayed to the right of the selected device.

NOTE: YOU CAN ONLY OUTPUT TO DEVICES THAT HAVE BEEN CONFIGURED.

Panel Size - Panel Size refers to the smaller of the maximum production area of the
output device or useable medium in the device. Confirm that the Panel Size is 17,11 for
the purpose of this tutorial.

Weed Border - Select B to cut or draw a weed border around your sign for Output.
From the Output menu, access B Weed Border. FULL draws a box around the entire
Drawing Size. In the LINE mode, the box fits only around the group of text lines being
displayed. For this lesson, choose FULL.
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Output - Now, you are ready to output to your plotter. Make sure your plotter is on-line
and ready to go. Select O and Stencil-Art will start the output to the plotter. If the plotter
does not plot, an invalid communication status has been detected. Cabling problems
are typically the cause of this error or your plotter may be off-line, or configured
incorrectly.

While plotting, look at the bottom right of your screen. There is a little printer icon
shown. This indicates that the Windows spooler is busy. Double click the little printer
icon. You will see the name of your sign (UNTITLED) listed there. This is your job sent
to the plotter. If you need to cancel the output, select the job and delete it by pressing
[Del] on the keyboard. The little printer icon will disappear when all information has
been sent to the plotter. Plotters with large buffers may continue to run for some time.
Once your sign is finished plotting, press Cancel on the Output menu to return to the
main screen.

You only have one line of Text in your sign. It's time to add a second line and learn
about other functions.

Edit | Insert Line feature

Insert allows you to add new lines of text to your sign at any line position. To add new
lines of text at the end of your sign, you can simply enter a line number that does not
exist. Pull down the Edit menu and select Insert Line or select [\] from the side menu.

A new Text entry box appears. Enter your street address as the Text. Press [Enter].
Stencil-Art prompts:

/nserted [ine number

Type 2 and press [Enter]. Now your line will be drawn on the screen. As you can see
the status bar information changes and now it represents Line 2. The new line is the
active and ready for editing.

Notice that Line 2 was automatically placed below Line 1. When a line is inserted it
assumes the characteristics of its preceding line, (Height, Font, X location, etc.), with the
exception of the Y location. While inserting Text, Stencil-Art sets the Y placement of
Text for each new line according to the Line Spacing parameter which can be set from
the Hot Key pull-down menu or by pressing [=] on the keyboard.

= Line Spacing - Line Spacing places new lines of text below the preceding line of text
by a specified amount. This is helpful for multi-line signs where Y placement would
otherwise be more difficult. Line Spacing also controls the increment of movement of
the + Line, - Line features which allow vertical movement once a line is placed.

Pull down the Hot Key list by pressing the red button on the side menu. Notice Line
Spacing is set to 1.5. When you inserted Line 2 it was automatically placed 1.5 inches
below Line 1. This value is an adequate amount of spacing between lines of text for the
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current height of text. For larger text, the amount entered for Line Spacing would need
to increase. A good first guess is 1-1/2 times the height.

Pressing [\] or [Esc] adds a new line automatically placed below the previous line. The
automatic Insert mode continues line after line until you select the Output menu or Edit |
Select Lines sub-menu, or any File menu options (except Save and Save As) which will
end the automatic mode. If you then use [\] feature, you will be prompted for a number
for the new line. When you insert a line, the number that you give determines not only
the sequential place of your line but also how it will look when it first appears.

Edit | Select Lines sub-menu

The Select Lines sub-menu allows you to hide and to select which lines from your sign
will be displayed. Using your mouse, click on Edit in the menu bar and choose Select
Lines. A list displays all lines of text contained in the sign file. At this point you may
scroll left and right and up and down the list to view the line parameters. You can also
select which lines of text are to be displayed.

To try this, select the Toggle option and click on the list at a row of your sign inside of
the View column. You can see that the cross mark x disappears from the line. Click
again and the cross re-appears. Each of the lines that has a cross mark in the third
column will be displayed. So if you want to hide lines, you can select Off or Toggle them
Off and then click on OK. Try this feature several times. Select both of your lines again
and let’s continue the Tutorial. Selecting a color affects all lines of the same color.

Between Space - Between Space refers to the space between letter pairs in a line of
text. When Height and Font are entered, [B] Between Space is automatically set to
12% of the text Height. This entry allows you to set a new Between Space value to help
fit text into a particular area or Edit Length. Select B and you can see that the present
value is 0.108 which is exactly 12% of 0.9 - the Height of the capital letters of your text.
The value you set can be any number, positive or negative, or a decimal fraction of a
number.

Enter a Between Space value of .08, and notice the letters of Line 2 are closer together.
Now try different positive and negative values to make your letters further apart, closer
together, or overlap. After setting the spacing back to .08, select the Edit | Text sub-
menu again. Notice Edit Length has been automatically computed and adjusted for the
new Between Space.

For the purpose of this tutorial, select E and set the Edit Length back to 10.000. The
Between Space and Width are readjusted by this entry.

Let's create Line 3 and learn how to condense and extend Text using the Width feature.
Press [Esc] or click on the [\ ] button from the side menu to add a third line of text. You
are still in the Insert mode and Stencil-Art prompts for Text entry. Enter your city and
state abbreviation for Line 3.
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Width - Let's adjust the [W] Width of Line 3. A Width value of 100 means text is 100%
its normal width and is undistorted for its Height. The value of Width reflects whether
letters have been condensed (W value smaller than 100) or extended (W value greater
than 100). Letters with Width set to 200 are twice as wide as letters with Width set to
100.

For Line 3, experiment with setting different Height and Width values to create
interesting effects. Enter a Width value of 200 to display extended text. Or try entering
a Width value of 50 for condensed text. Just for fun, press the [Ctrl] key down on the
keyboard and hold it while clicking inside the Line 3 area (the active line) with the left
mouse button. You can see the text handles look different now. We will call them the
Second Handle Set.

Slide your mouse over a handle. The mouse pointer is changed and the pop-up label on
the side menu displays which line parameter can be adjusted by this text handle. The
Second handle set can be manipulated exactly like the first one - you can drag and drop
the handle or you can click the handle and tune the present line parameter by using the
keyboard arrows or by sliding the mouse.

Try editing the Width value by the appropriate text handle from the second handle set.
Change the cursor movement and play with the handle again. For the remainder of the
tutorial, set the Width back to 100.

Font - Each line of text in your file must have a font assignment. This is the type style
or typeface used to present the text. Font is found in the Edit | Text sub-menu but let's
not display the menu to select a font:

Select F from the side bar menu with your mouse, or type F on your keyboard.

You can select a font style by entering the number code listed to the left of the desired
font or by selecting the font with your mouse or by using your keyboard arrows to move
through the font list. Choose any font style you like; try them all! If you don't make a
new selection the present font is retained when you escape from the listing or click on
the CANCEL button.

A single character of the selected font is displayed. Any character from A-z, including
punctuation characters may be typed to give you a preview typeface. If you have more
fonts than can be listed at one time, press the PgUp or PgDn keys on your keyboard or
click on the vertical bar in the font listing to scroll through the list a page at a time.

NOTE: CATALOGS SHOWING ADDITIONAL FONTS TO ADD TO STENCIL-ART ARE
AVAILABLE. THESE FONTS MAY BE ORDERED INDIVIDUALLY TO MEET THE SPECIFIC
CRITERIA OF YOUR CUSTOMERS. WHEN YOU INSTALL NEW FONTS IN YOUR SYSTEM, THE
EXTENDED FONT TABLE WILL BE ORGANIZED ALPHABETICALLY WITH NEW SELECTION
NUMBERS. THIS WILL NOT AFFECT YOUR SIGN FILES BECAUSE STENCIL-ART REMEMBERS
FONTS BY NAME.

For the tutorial select the font SGI71155 - Souvenir Bold. This font comes in your basic
font package. Click on the OK button or press [Ctrl + O] on the keyboard to return to
the main screen.
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Line # - Line # indicates which line number is currently being edited. To help you
maneuver quickly between the lines, the next exercise deals with changing lines.
Locate the Line # feature at the beginning of the status bar. The fastest way to select a
line is to click in the area of the text on the screen. You may need to slightly adjust the
cursor position and click again if two lines are overlapping in the portion of the screen
that you need to click.

The Line # feature allows you to select a specific line number for editing. Click on the
status bar on the Line # word and you can scroll between all of the displayed lines of
your sign. Right mouse button click will scroll down. Use the left mouse button to scroll
up. If you click inside the box where the line number is shown, a prompt will ask you for
the line to become active. '

You can use the [<] and [>] keystrokes to select line. Remember, lines can be hidden.

< Selects the preceding line for editing; [Ctrl + <] Selects the preceding displayed line.

> Selects the following line for editing; [Ctrl + >] Selects the following displayed line.

The Line # feature may be accessed from the screen with or without the Edit | Text sub-
menu displayed.

! Text Mode - Located in the Edit | Text sub-menu, Text Mode controls how Between
Space, Width and Edit Length are affected when Font or Height are selected. Text
Mode can be changed at any time to couple or uncouple the effects of other entries.
You probably noticed how Edit Length changed with Font selection.

In the Auto mode, Stencil-Art adjusts Width and Between Space values for the given
Height or Font selected. This keeps the lettering Width artistically undistorted and
proportionately spaced for any Font. Wide [W] gets more space than the narrow [I]..The
Manual mode uncouples these effects.

From the Edit | Text sub-menu, locate the ! selection on your screen. Toggle between
Auto and Manual. Set the mode to MANUAL and work through the Font, Height,
Between Space, Edit Length, and Width selections with different entries.

View the effects of the Manual mode when selecting other entries. Practice in both the
Auto and Manual modes so that you learn how to hold the length and spacing constant
when changing letter height. Use the manual mode for menu boards needing prices in
evenly space columns.

Output to the Plotter - Since you have been experimenting with so many new
functions, it is quite possible that your lines are not in order. Set the ['] Text Mode back
to Auto. , Line up the text one line below another. Re-enter any adjusted entries and it's
time to wrap up the Level One Tutorial

Produce All - Produce All is the fastest, most efficient method of output to the plotter.
This function allows you to immediately output all lines of text in your sign regardless of
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the lines selected for editing or for output. Verify that PLOTTER-1 is the selected device
and send your sign directly to the plotter.

Select A to output your sign.

You may want to try a few more three-line exercises, varying the fonts and letter sizes,
etc. Practice as much as you need to be confident of your accomplishment and be
ready to go on to the Level Two tutorial.

Access Files menu to save this tutorial work. If you select to Exit, you will be prompted
about saving:

SAVE CHANGES?
[Yes] [No] [Cancel]

Select [Y] to save your sign. A list of the present sign files is displayed. We want to
save this file as a new sign so, simply type a file name that does not currently exist in
the list. For this tutorial, type:

LEVEL1

You can also type a description for the sign. The description is shown with the sign
listing and aids in recalling your existing signs. For the description of LEVEL1, type
Level One Tutorial. Click the Save button. You are exited from the program.
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LEVEL TWO TUTORIAL

The Level Two Tutorial will build on your previous knowledge. You will use the Level
One sign as a pattern to create a different sign for Level Two. The entire tutorial is a
building block for your Stencil-Art skills. Level Two will teach you to change the layout of
the original three lines by using additional menu selections.

In Level Two, you will learn to arc Lines 1 and 3 of your sign, making them appear in a

circular shape when plotted together. You will also learn how to edit and italicize Line 2

and place it inside the circle formed by Lines 1 and 3. Your final output will look like this:
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Level Two focuses on the Edit and Transform menus of Stencil-Art. General editing
processes are available from these menus, including line insertion, copy and deletion,
moving a group of lines, creating multiple copies of lines, and editing several lines at
once.

If you have just started Stencil-Art after completing the Level One Tutorial, you are
looking at a blank screen with the menu bar for selection. This tutorial begins with
recalling an existing sign file as a pattern for a second sign file.

Open File

Open file is used to recall an existing file. Select the Open feature of the File menu. A
list of the current sign files is presented for entry. The path selection allows sign files to
be accessed from directories other than the current sign file directory. We will access
the sign file which was created in the Level One Tutorial. Click on LEVEL1 in the sign
file list. The file name is highlighted indicating that it was selected. If you push the
Open Button now you will open the sign, but let’s first see two very useful features.

Select the Sign Preview option by clicking inside of the empty box on the bottom and a
miniature preview of the highlighted sign appears next to the sign list. Uncheck the Sign
Preview option by clicking on the check mark and the preview screen disappear. Sign
Path can be changed again. Note that pressing the [DEL] key in the preview mode will
delete the sign selected. You can try this but then say NO to the verify question or you
will lose your work from the first tutorial.

Double click the file name from the list. A list of all lines in the sign is presented. From
this list, you can select the lines required for editing. The cross marks to the right of the
line numbers identify active lines. Since all three lines are selected with a cross mark,
press the OK button to display all three lines. The sign is drawn on the screen and
ready for additional editing.
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Blind Menu Keys .

To assist with text entry, text correction, and special character spacing problems,
Stencil-Art provides several Blind Menu Entries that are not displayed in any of the
Stencil-Art menus or sub-menus but are available any time a text string is being edited.

These keys assist in correcting spelling errors or fine tuning the letter spacing. Blind
Menu Keys are also available for text entry for Comment line, and when naming a disk
file. The Blind Menu Keys are listed below:

[F1] Help.

[DEL] Deletes character above cursor,

[BS] Deletes character in front of cursor.

[INS] Toggles between overstrike mode and insert mode. The text is
colored in red to indicate the overstrike mode while black text shows
insert mode.

[Home] Places the cursor at the beginning of the entry.

[End] Places the cursor at the end of the entry.

[F7] Floats following character up 1/5 of Height from text base line.

[F8] Floats following character down 1/5 of Height from text base line.

[F9] Increases kerning of the letter pair to move letters FARTHER APART

by 1/20th of a space key. Input text is not affected.

[F10] Decreases kerning of the letter pair to move letters CLOSER
TOGETHER by 1/20th of a space key. Input text is not affected.

[Shift + -] Select a portion of a text string. Move the cursor to the beginning of
the text portion. Keep the [Shift] down and press the right arrow key
[->] until all of the desired text is highlighted. With the mouse - place
the mouse pointer at the first character, slide the mouse to the right
with the left mouse button pressed. Release the mouse button when
all of the desired text is highlighted.

[Ctrl + C] Copy the selected text to the Clipboard, where it becomes available
for all Windows applications that use text strings.

[Ctrl + V] Pastes the text from the Clipboard to a Stencil-Art edited text string.
The pasting will start from the cursor position. ]

With the last three features you can insert text into Stencil-Art from any text editor
(Microsoft Word, Notepad, etc.) Open the text editor, open a document and simply type
some text. Then select and copy some text to the Clipboard, using [Shift + -] and
[Ctri+ C]. Return to Stencil-Art. Press [ESC] or choose the [\] button from the side
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menu to insert a new text line. Then, paste the text from the Clipboard [Ctrl + V].
Handy, isn't it!

If you just created a new line using the instructions above, you can delete the line now
because we will not need it for the tutorial. To delete the line, press the [Del] key on the
keyboard or choose the Delete line feature from the Edit menu.

PLACING LINE 1

Now you are going to place the text of Line 1 over the top of a circle as an arc. The arc
is made by using both the Angle Rotate and Radius Arc entries. To understand this
concept, think of a circle defined by a line (radius) which is measured from the center
point to the circle edge. A circle always has a total of 360 degrees. If you take a piece
out of that circle (for your name), the angle to locate the piece is measured in degrees.
Arced lettering uses a circular baseline with the bottom of the letters placed around the
circle.

First you must enter a value for Radius Arc which is located in the Transform menu or in
the side menu bar.

Radius Arc - Radius Arc [R] controls the circle size for arced lettering. It determines
how far the circle will be from the X,Y center point and the direction of the text on the
circle. The letters themselves will not be curved, but will be tilted to fit in position on the
circle. The baseline of each letter will touch the circle. Select R on your keyboard or
click on the side menu R button to change the Radius Arc. In the status bar you will
see:

Radius Arc = 0.000.

For this tutorial, enter the Radius Arc as 2 and press [Enter]. Numbers with decimal
place need a period. If using a mouse, click on R in the side menu bar. Move your
mouse up for a positive radius value or down to designate a negative radius value.
Press the left mouse button again and the arced text box represents the arc you have
just created. A line extends from the X,Y position (circle center) to the justification point
on the arc.

NOTE: FOR ARCED LETTERING THE X,Y COORDINATES DO NOT REPRESENT THE
PLACEMENT OF TEXT, THEY ARE THE CIRCLE CENTER POINT. THE CIRCLE ITSELF MAY
EXTEND OUTSIDE OF THE DRAWING SIZE AS LONG AS THE TEXT REMAINS VISIBLE ON THE
SCREEN.

The cursor should be at the X,Y center point 5.5, 4.5. Your name should be centered
over the top. When a value is entered for Radius Arc, Justification defaults to CENTER
and [A] Angle Rotate defaults to 90 degrees. When the Radius Arc is positive, letters
are outside of the circle and clockwise. When the Radius Arc is negative, letters are
inside of the circle and counter-clockwise. Press R or click on R with your mouse and
make the Radius Arc a negative value to experiment with positive and negative values
affect text positioning..
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Now that you've experimented with this valuable feature, change Radius Arc back to
+2.0.

Angle Rotate - The Angle Rotate value allows you to change the position of the text on
the circle. A value between -360 and +360 may be entered. Select [A] from the
Transform menu, side menu or keyboard. The right side of the status bar shows:

Angle of Rotation = 90.000

For fun, try entering different combinations of Angle Rotate, Justification and Radius Arc
to see how the text changes position on your screen. Arced text can only be LEFT or
CENTER justified.

Remember, for arced lettering, the X,Y coordinates do not represent the placement of
text, they are the circle center point. The X,Y values can be negative or greater than the
X,Y sign size to compensate for the radius value. The circle itself may extend outside of
the Drawing Size as long as your text remains visible on screen.

When you enter [R], it will not change X,Y coordinates but will move the text to new
radius. Try using the upper left editing node to stabilize the text positioning while
changing the XY center. The edit node technique will only work when the [R] is non-
Zero.

The aesthetics of arced letters are very sensitive to letter pair spacing. Use [B] between
space and the [F9] and [F10] text blind menu keys to fine tune the spacing of arced
text.

For the final position of Line 1, keep the Angle Rotate at 90.00 degrees with Centered
Justification and a Radius Arc value of 2.0. These values will display the text perfectly
upright on an arc. You may need to adjust Width, Between Space, or Edit Length to
have your name use only the upper half of the circle.

PLACING LINE 3

With Line 1 positioned on an arc, you are ready to place Line 3 on the bottom half of the
arc. The placement of Look at the X,Y coordinates for Line 1. Then select Line 3 by
using the [<] (or point and click with the mouse) and set the same coordinates. Then
enter the [R] as -3. Be sure Line 3 has the same coordinates. Then select [R] and
enter —2.9 to make the lettering go counter-clockwise and match the arc of Line 1. Line
3 must go in the opposite direction of Line 1 and also compensate for the radius to the
bottom of the letters.

To place the letters inside of the circle and in the opposite direction, the radius must be
negative. To calculate the Radius Arc for Line 3, add the Height of the letters in Line 3
(.9) to the Radius Arc of Line 1 (2.000) and make it a negative value (-2.9).

When a negative Radius value is entered, the angle is automatically adjusted to -90
degrees to form the bottom half of a circle. Notice the line extending from the X,Y circle
center to the new justification point of text on the arc.
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EDITING LINE 2

The next step is to edit Line 2. Select Line 2 by clicking on the text area (your address)
with your mouse or by using the [<] key. Edit the Text to be only your initials. To speed
up editing, place the mouse before the first character, push the left mouse button down
and move the mouse alongside the text to the last character. Release the mouse
button. The whole text is highlighted. Type your initials directly. As you can see
everything highlighted is replaced by the new text string. Click on the OK button.

Center Line 2 between the arcs of Lines 1 and 3 using the arrow keys or your mouse.
Work with the X,Y location for best aesthetic placement. Try using the four arrow keys
or mouse movements in conjunction with the PgUp / PgDn keys for arrow step
adjustment. You may need to adjust the Height, Width, Between Space or Edit Length
of Line 2 so that it fits neatly between the two arced lines.

Select Lines - Access Select Lines from the Edit menu to change the line or range of
lines you are displaying on the screen. Isolate Line 2 for the purpose of this exercise:
Push the Clear All button to deselect all three lines. Now select the ON option and click
on Lines 2 and 3. Click on the OK button. Click on Line 3 and then hold the [Crtl] and
press [H]. This is the Hot Key method to hide a line.

Notice that Line 2 is the only line displayed for editing. We will use Line 2 to learn about
other features.

Italicize - ltalicize sets the degree of slant for text. Positive numbers will lean text to
the right/forward. Negative numbers will lean text to the left/backward. You can ltalicize
up to 60 degrees in either direction. Select | from the Transform menu, press [I] on your
keyboard or on the side menu, or with your mouse use one of the upper corner text
handles from the Second handle set. The left side of the status bar shows:

Italic Angle = 0.000.

Enter any number between -60 and 60 to ltalicize the text. If you are using a mouse,
slide your mouse left and right and watch the text box slant to reflect the Italic value.
The new angle value represented by mouse movement is reflected in the status line.
Try positive and negative numbers to understand how this feature changes the
appearance of your text.

For the final slant of Line 2, set ltalicize to 30 degrees. If necessary, adjust Height,
Width, Between Space, or Edit Length to fit the text on the screen.

Select Lines Button - Now you are ready to output your Level Two sign to the plotter.
Since Lines 1 and 3 are not currently displayed, they must be selected again for output.
Press the Select Lines button from the Output menu and a listing appears displaying all
lines of text contained in your sign. Each line with corresponding parameters is
displayed for selection. Notice that only Line 2 is currently selected for output. (This is
the only line with a cross mark to the right of the line number.) Let's unhide Lines 1 and
3 for final production of the Level Two Tutorial.
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Press the Select All button and Lines 1 through 3 are selected for output. Click on the
OK button to return to the Output menu for final output.

Output Lines Button - Make sure the device is set to PLOTTER-1. Set Weed Border
to FULL and make sure the Velocity under Details is set to an appropriate value.

Select Qutput Lines. Your plotter should cut the sign.

Save As - In the Level One Tutorial, we initiated a file named LEVEL1. In the Level
Two Tutorial, we opened LEVEL1 and made additional changes. We now want to save
the changes made in the Level Two Tutorial as a second sign file. Save As allows an
opened sign file to be saved under a new sign file name. This results in a new sign file.
This feature is useful when two signs have similar layouts, but some parameters need
to be changed. For this tutorial, we will retain LEVEL1 and save all changes made in
Level Two to a different file.

Access Save As from the File menu.

The Save listing is presented showing all sign files in the current sign directory. This
listing allows you to save the file with a new file name, or as a file name that already
exists. If you choose a file that already exists, the previous sign information will be
overwritten.

We will save the changes made to LEVEL1 as a new sign file. Type LEVEL2. For the
description of LEVEL2, enter Level Two Tutorial and click on the Save button.

The main screen now is titled LEVEL2 as the sign in progress.
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The Level Three Tutorial is the most challenging of the exercises and will help you learn
even more features of Stencil-Art. Level Three Tutorial teaches you to take the three lines
produced in Level One which were arced and italicized in Level Two and repeat them into a
twelve line sign.
This tutorial will teach you how to output to the plotter in a series of panels that will look like
this:
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Let's begin. The Level Two Tutorial left you in the sign file LEVEL2.

If you are not continuing from the Level Two Tutorial and are just entering Stencil-Art,
access the File menu and Open LEVEL2 sign. We will later save our changes as the
LEVELS file.

The Drawing Size for the sign saved with the Level Two Tutorial was 11" wide by 8.5" high.
This tutorial will require a sign area four times as wide. Select [D] and change the Drawing
Size to 44" wide by 8.5" high. Notice how the Drawing Size affects the proportional display
of your sign.

Group | Edit

The first step of this tutorial is to use the Group Edit feature to simuitaneously change
multiple lines of text. Drag your left mouse around all three lines of text, then release. All
lines should be highlighted and “Group Operations” is displayed in the status bar. Single
lines can be added or removed from the group. Hold down the shift key and then left
mouse Line 2. The line will be removed from the highlighted group. Do this again to add
Line 2 back to the group. Pull down the Edit menu, select Group and choose Edit. A list of
your text lines will appear. If all three lines are already selected, press the OK button. The
status bar will show:

-—-- GROUP OPERATIONS -

While we could group edit any of the line parameters of the selected lines, for practice in
this tutorial, we will change the Font of all three lines of text.

Select Font to list the fonts in your system. Use the mouse to select SGI171120 - Clarendon
Medium and press the OK button. Notice that all lines of text are now in Clarendon
Medium. Select [C] and change their color.

Group | Step & Repeat

The next step in the tutorial is to use the Step & Repeat function to duplicate the present
three lines into four identical copies, side by side in your enlarged sign area. Select the Edit
menu and locate the Step & Repeat option under Group.
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The total X,Y dimension of the group determines the required physical distance from one
group repetition to the next. The columns and rows of the array determine how many
repetitions of the text are made.

Select Group | Step & Repeat from the Edit menu which then prompts:

First, last line
Enter 1,3

The first through last lines specified will be repeated by the process. If only one line is
entered, it will be treated as the first and last line. The Repeat Lines sub-menu appears.
Width and Height values show the exact dimensions of the group area, i.e. if you leave
these numbers unchanged the neighboring groups will touch each other. Increase these
values to create space between the groups.

We'll use a simple approach for calculating the size of the group by repeating the entire sign
size of 11, 8.5 that were set in the Level One Tutorial. Enter 11 for the Width and 8.5 for
the Height values.

Two numbers are then needed, the number of COLUMNS and ROWS. COLUMNS
determines the number of horizontal repetitions, or how many copies 11" wide. ROWS
determines the number of vertical repetitions, or how many copies 8.5" high. To create four
complete groups side by side: Enter 4 for Columns and 1 for Rows.

Take a look at the four colorful icons on the top. The red box represents the original. Use
these buttons to define the direction of offset reproduction. In our case any of the first two
options can be selected, because we are not going to create new rows of repetitions. The
first option is selected by default.

Press the OK button to finish the job. Your sign will now have a total of 12 lines and the X
coordinates of each line group will be 11.0 inches apart. The Y coordinates of each group
will be repeated.

Group Delete

This feature deletes lines and all corresponding information of the lines specified. While the
[DEL] key could be used for one line at a time, we will use the Group | Edit | Delete to
remove the 9 lines of repetition. Click on Clear All button -all cross marks disappear.
Choose the ON option. Point with the mouse on line 4 at the second column of the list.
Press the left mouse button and drag to the last line #12. Release the mouse button when
all of the lines from 4 to 12 are highlighted. Notice that 4-12 have cross marks and 1-3 do
not. Select the OK button and confirm. Only the original three lines of your sign are
displayed. Redo the Repeat Group for practice.

Zoom

To take a closer look at the details of your text, use the Zoom feature to see an enlarged
portion of your sign. The Zoom functions can be accessed in any of the following three
methods:

using only your right mouse button;
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by typing Z with no menu pulled down and operating with the arrow keys from your
keyboard;

from the View menu.

Zoom In option - To set a Zoom In means establishing a rectangular area of your sign that
you want to see in more detail.

By mouse: Move your mouse to one of the corners of the imaginary zoom window. Press
your right mouse button and drag toward the diagonally opposite corner of the same
imaginary area. A red rectangle appears. As you can see, one of the corners is at the
starting point and the opposite corner is connected to your mouse. Release the right mouse
button when the red rectangle surrounds the desired area.

By keyboard: Press Z on your keyboard to begin. A red rectangle rims your sign. The
starting point of the Zoom window must first be established. Use the arrow keys (one
increment at a time) to move the rectangle so that one of its corners reaches the desired
starting point. Press [Enter]. Use the arrow keys again to establish the width and the height
of an area to be zoomed and press [Enter].

From the View menu: Select Zoom In from Zoom menu of View menu. A red rectangle rims
your sign. To establish the zoom window, use the arrow keys to establish the window
corners.

The Zoom window may be positioned to encompass any or all portions of your sign. If you
are zooming with the mouse, opposite corners of a Zoom window may be selected in any
order.

The window can be moved 25% at a time or to the limits of the sign by clicking the arrow
buttons invoked by Zoom In function (look at the lower left corner of the main screen).
These buttons will disappear when you are back to a 100% view.

When Zoom is more than 100%, the four arrows on the outer edge of the display screen
allow you to pan or move the viewing area with your mouse while retaining the Zoom factor.
The keyboard can also be used to pan when zoomed. The keyboard keys used are
[Home]=Left, [End]=Right, [Ctrl + PgUp]=Up, [Ctrl + PgDn]=Down.

Zoom Out option - This feature will return the viewing area of your sign to the previously
established Zoom window.

By mouse: Double click with your right mouse button inside the displayed portion of your
sign.

By keyboard: Press [Ctrl + Z].
From the menu: Select Zoom Out from Zoom sub-menu of View menu.

Normal View option - Selecting Z and pressing [Esc] will reset Zoom to the full Drawing
Size dimensions.

Group | Move

Group | Move allows you to move or transpose the XY positions of a group of lines in your
sign by the same amount. This does not Create additional lines of text as does the Group |
Step & Repeat function. It moves X and Y at the same time.
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Before beginning the process, select Group | Move from the Edit menu. The list of your
lines of text appears. Press the Clear All button, choose the ON option and select the first
six sequential lines. Notice the current X,Y values of lines 1 through 6 before they are
transposed.

Click on the OK button. The following prompt appears:

X, Y TRANSPOSITION
Type -1,-1
The values entered are ADDED to the existing X and Y values of all lines specified. Notice

the six lines specified have moved one inch to the left and one inch down. The other six 6
were not moved.

If all lines fit onto the screen you are home free. If not, apply Group Move to the necessary
lines to shift them to the right or up as needed.

Move Group hints:
A POSITIVE X value moves the lines RIGHT. A NEGATIVE X value moves the lines LEFT.
A POSITIVE Y value moves the lines UP. A NEGATIVE Y value moves the lines DOWN.

Group Rotate

Drag the left mouse around all three lines and release. Select Edit | Group | Rotate. You
are prompted to enter a rotation point and angle. Try experimenting with different values.

Project Resize

A group of lines can be resized with the TRANSFORM | PROJECT RESIZE by entering the
new dimensions. All pieces and their placement will be automatically adjusted
proportionally. Note that when multiple lines are involved, the Proportional checkbox will
always be selected.

Panelization
You are now ready to complete this tutorial. Select the Output menu and PLOTTER-1 as

the output device. Verify that the Panel Size is set to 17,11 for PLOTTER-1. The 12 lines
should appear on the screen in a series of panels. Use [S] lines if needed.

Panelization outputs a large drawing in a series of smaller panels to overcome plotter and
material size limitations. It allows continuous output in length and the ability to create text of
virtually any height and length. This technique also helps move material through a plotter in
a forward and limited manner.

After selecting all lines for output, notice that your sign is fully displayed but is divided into
numbered panels. Stencil-Art automatically sets up for Panelization when your drawing size
is larger than the device Panel Size. For our tutorial, output to the plotter will be in panels or
tiles of 17,11.

Compare the Panel Size in the Output menu to the Drawing Size in the Layout menu.

Select the Layout menu and confirm that the Drawing Size is 44, 8.5. Select Plot Settings
from the Output menu and note that the Panel Size for PLOTTER-1is 17,11.
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Let's experiment with features of Panelization before outputting to the plotter.

Set Window - This feature may be used for standard or Panelization output to produce
one portion of a sign. Setting a window can be very useful to output a small area damaged
in a larger sign production process or to produce a small part in a separate color of
material..

Notice that a window box surrounds panel 101 in the lower left corner of your screen. The
window lower left corner is treated as the origin and placed at the plotter origin. This
window can be moved by selecting E.

Select E and use the arrow keys or your mouse to set the lower left area of the window.
Press [Enter] or click the mouse to set the lower left corner. Position the upper right corner
with the arrow keys or by dragging your mouse to enclose only the area to be output. Press
[Enter] or click your mouse to set the upper right corner.

Once the window limits are specified, the program asks if the window is to plot at the current
position. Selecting [Y] will plot the window at its designed position (great for re-inking a
missed area). Selecting [N] sets for the window to be plotted at the 0,0 plotter origin
(eliminating a lot of otherwise wasted film).

Window Output - This feature may be used for standard or panelization output to produce
ONLY the portion specified by Set Window. Windowing can help assure that graphics and
text are not cut in half or are cut in less noticeable places.

Qutput Lines - When using Panelization, Stencil-Art will advance your plotter for each
panel, reset the plotter origin, and continue plotting. It is not necessary to adjust the plotter
in any way during Panelization. The vertical line between continuously produced panels is
never cut. Plotter output from one panel to the next is consecutive and continuous with no
vertical panel separation cuts. Stencil-Art makes the lower left corner of the last panel the
new origin.

Select the [0] Output Lines to begin the Panelization process to the plotter. Stencil-Art
prompts for the consecutive panels to be output:

Input First, Last PANEL

Enter 101,103 and watch the plotter do the work. It should make four identical copies of
your original lines.

Frame Advance - Notice that the plotter origin is now at the beginning of the last panel.
Stencil-Art output the full 44, 8.5 drawing size in three panels each 17,11. The final position
of the plotter is now at the beginning of the last panel, or 17 inches (1 panel size) from the
end of the drawing.

If this drawing was less than or equal to the panel size, the final position would be at the
beginning of the drawing. This is useful when you need to plot the drawing again or may
want to use another part of the film. You may need to cut twice through thick material, or
your pen may have run dry in the middle of a plot requiring re-plotting at exact positions.
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The Frame Advance feature advances the plotter one full panel size in the length value.
Select Frame Advance and watch the plotter advance 17 inches.

Stay at Plot End - This option is similar to outputting plus selecting Frame Advance
afterwards. If the option were checked, the plotter would have advanced automatically to 1
inch after the maximum X point of the last panel and reset the plotter origin to this new
position. For small jobs, use stay at end of plot and just press Output to make extra copies.

In Level One Tutorial, we initiated a new sign and saved it as LEVEL1. We opened LEVEL1
in the Level Two Tutorial, made additional changes and saved those changes as LEVEL?2.
In Level Three Tutorial, we have made changes to LEVEL2. We will save those changes as
a third sign. Access the File | Save As sub-menu. Enter LEVELS3 as the file name. Enter

Level Three Tutorial as the description and click on the Save button. Use File | Exit to
close the program.

If you have any problems with this tutorial exercise, consult the Users Guide for additional
information on every menu entry or use the On Line Help [F1].
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The Level Four Tutorial will teach you how to add elements to your permanent graphic
library and how to use them in Stencil-Art. Most of this tutorial is not applicable for sites that
have not ordered the scanning software option. These steps will be marked with an asterisk

()
Let's learn the basic difference between raster and vector file formats.

Raster: A raster image consists of thousands of colored dots. If the image is Black and
White (B&W), the dots are only black or white. If a raster is a 256 color image, each dot is
colored in one of 256 colors. There are color images that have millions of colors. Raster
files are also called “bitmaps”.

The B&W images are much easier to deal with than color images. Raster editing is simple -
we draw with black and we erase with white.

The most popular sources of raster files are scanners, digital cameras and captures from
the Internet. The most commonly used extensions for raster files are .BMP, .PCX, .TIF,
JPG and .GIF. They can be printed, but cannot be cut.

Raster images do not always distort or scale well and result in a poor visual image in some
cases.

Vector: A vector file is a sequence of outline paths about how to move from point A to point
B, i.e. starting from point A, draw a curve or line to point B.

The most commonly used vector file formats are .Al, .EPS, .PLT and .DXF.

Vector files can be printed and cut. They distort and scale well. Vector information is also
used to make your plotter move. Stencil-Art works with vector files.

Adobe Streamline 4.0 *

This program helps you scan and convert raster images to vector files that can be used in
Stencil-Art. Let’s learn how to use Adobe Streamline.

Raster images appear in Streamline either through File | Open (open a disk file) or through
File | Acquire (scan a paper pattern). For the tutorial we are going to use a stored raster file
TUTO4-1.TIF.

Open Adobe Streamline 4.0. Choose File | Open. Select the main Stencil-Art folder in the
Look In box. Select TIFF (*.TIF) in the Files of type box. Open TUTO4-1.TIF file.

Pull down the View menu and select the Show Info command. Click on the little key icon on
the bottom right of this menu so you can see the full image information. This file has 300
DPI (dots per inch). When you have more scanning experience, you will be able to quickly
decide what resolution to use by looking at the quality of the artwork, but for now let’s stay
in the 300-450 DPI range.

As you can see, our example is a portion of a bigger pattern. We want to isolate and store
the flower in the Stencil-Art permanent graphic library as a separate element. Separate
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elements are easy to combine, rotate and size independently from each other. They can
then be included in different jobs.

Raster editing is less time consuming than vector editing. We will try to do most editing in
the raster before the final conversion. Streamline’s Raster/Vector conversion is extremely

Example
7F/

results. Use the

Bitmap Editing *

Editing of the artwork pixel image will be needed in several places. Unnecessary lines need

|

fast and we can do multiple conversions just to
discover problem areas.

Let's do a fast conversion. Select the Options |
Conversion Setup menu and choose the
“Centerline” method with the “Separate Shapes”
options. Clear the “Outline” method and click
on the OK button.

Select the File | Convert menu and watch the
conversion in progress. You can see that
despite extra lines and some noise the flower is
traced correctly except in the areas shown
below.

Select the Art &Raster and Artwork display
options and take a close look at the conversion

magnifying glass tool to zoom in each area.

to be broken. Thick intersections need thinning. Filling holes in the ink lines may be

required.

There are several tools for editing the bitmap image:

Marquee tool
Lasso tool
Magic Wand
tool

Pencil tool

Line tool

Eraser tool

Eyedropper tool
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Lets you select rectangular area for deleting or conversion
processing.

Lets you outline areas for deleting or converting to vector
image.

Makes a selection based on a 3-pixel spread surrounding the
pixel you click with the magic wand tool.

Lets you paint freehand lines in the color from the toolbox
swatch.

Lets you paint constrained or unconstrained straight lines.

Lets you change the color values of pixels (“erase” them) to
white.

Lets you select a color from the bitmap image.
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These tools are available only when you are in the Raster Image mode. By double-clicking
any of the pencil, line or eraser tools you can change their thickness option. The Magic
Wand color tolerance can also be adjusted by double clicking the tool button. This tool is
extremely useful when you work with multicolor raster.

Switch back to Raster Image view, i.e. pull down the list that is presently showing Art &
Raster and select Raster Image. Select the Eyedropper tool and click on a white portion of
the image. The color swatch on the toolbox changes to white. Select the Line tool. Double
click on it and change the line thickness to the second option.

Zoom in so that you can easily see the lines
to be corrected. [Ctrl +] will help you zoom
in. [Ctrl -] will zoom out.

Open the intersections as shown in the
picture by drawing short white lines to erase
unnecessary black pixels. Also break the
lines that were connecting the flower to the
rest of the design.

Change the color to black to fill in the
speckles in the raster. Try using the Pen tool
for this.

[CtrI+R] is the short key for the File | Convert
feature. Press [Ctrl+R] on the keyboard

now.

Conversion to Vector Image *

After the conversion is finished you will notice that several things on the screen are
changed:

1. The display options are automatically switched to Converted Art and Preview.
2. The raster editing tools are not available.
3. The File | Convert menu feature is no longer available.

The reason for this is that we are not in Raster Image display mode. If we wanted to
continue with the raster editing or to make another raster/vector conversion, we would
change the display mode back to Raster Image. However we need to do another
conversion on our example.

Set the display mode to Art & Raster and Artwork. Zoom in to the base of the flower. You
will see that there is a problem in the vector that looks like a double line where there should
be a single line. The truth is that the lines are doubled between pieces everywhere! When
the conversion is correct, these lines are exactly on top of each other. This is a result of
selecting conversion options Centerline + Separate shapes.

Having the gap closed between the pieces is important. This allows Stencil-Art to calculate
a consistent lead line relief and keep it despite the re-sizing or distortion of the graphic.
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So let's see how to fix the problem of separated lines. Select the Options | Conversion
setup menu. Usually the problem of separating lines appears when there is not enough Line
Thinning. Increase the Line Thinning parameter to 7 or 8 and perform another conversion.
Re-check the problem area.

Vector Manipulation *

Set the display mode to Art & Raster and Artwork and press [Ctri+A] (Edit | Select All
menu), then click on the View | Show Info menu. Notice the number of Paths that were
converted. Since you are doing line artwork, the number of Paths in the report corresponds
to the separate color pieces. In our simple example it is easy to count the number (5) of the
desired pieces. The rest of the paths are “noise” and later we'll show how to delete them.

Minimum Smoothing of the Paths *

Select all paths ([Ctrl+A]). From the bottom of the Edit menu, click on the Smooth Paths
feature. This is a very helpful first step in the vector editing process. It eliminates a
significant number of data points, smoothes, straightens out lines and combines arcs. ltis
important to keep the walls of the separate pieces together, so you do not want to do too
much smoothing. Normally, a minimum smoothing, applied only ONCE will do the job.
Zooming in and panning the entire graphic will let you see the effects. With line artwork, if
smoothing causes the vector paths to start separating from the original pixel artwork, use
Undo [Ctri+Z] to back up.

Vector Editing Tools

In this tutorial we are going to work with only two of the vector editing tools. You can find
more information in the Technical Notes about Streamline section of the Users Guide.
Select Path tool (the arrow icon)

1. To select a single path, click on it.

2. To select multiple paths, drag a window around. Paths have to be only partially in the
dragged area to become selected.

3. To add a path to the present path selection, keep the [Shift] button down while pointing

to the new path. The same technique applies to exclude a path from the present
selection.

4. To unselect all paths, click on a space that is free of paths.
The View | Show Info menu can help you find out how many paths are selected at the
moment.

The selected paths can be deleted all at once by pressing the [Del] key on the keyboard.
Remember that you have only one level of Undo. If a path has been deleted by mistake,
press [Ctrl+Z] to undo the last change.

Click on the Select Path tool and try all of the above techniques until you feel comfortable
selecting and unselecting vector paths.

o

Delete-anchor-point tool (the icon with the ™)
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Select all paths containing anchor points you want to delete. The anchor points become
visible when you select a path. IF AN AFFECTED PATH IS NOT INCLUDED, ANNEXED PIECES WILL
NO LONGER HAVE COMMON BORDERS.

Select the delete-anchor-point tool.

1. To delete a single anchor point, click the anchor point you want to delete. You can
repeat this step to remove more anchor points one at a time. You may want to do this to
see the path that results after deleting each anchor point.

2. To delete multiple anchor points, use the delete-anchor-point tool to drag and place a
box around the anchor points you want to delete. If all anchor-points of a path are
deleted, the path no longer exists. This is another way to delete a path.

Zooming in and out and using only these two powerful tools, you should be able to clean the
vector paths. Try to delete all anchor-points that are not absolutely necessary for the vector
paths to follow the raster. In our example, we find that only 31 points are needed for the 5
paths to hold the shape of the flower.

Saving the Vector Image File *

Select the File | Save Art As ... menu. Choose Save As Type “lllustrator EPS (.eps)”.
Locate the directory where you want to keep your vector files. Give a name and confirm.
Remember the directory where you save the .EPS files for retrieving the files in Stencil-Art.
For the tutorial save the file as FLOWER.EPS in the main Stencil-Art folder.

During the Save Art process you will be prompted for the type of preview you want to attach
to your vector file. Select None. This will keep your file smaller.

Open the Stencil-Art program.

Iniporting the Vector Image and Saving the .GNT Graphic File

The first step is to add the vector file from the scanned Raster to Vector conversion to your
permanent graphic library (files created by other programs, i.e. .EPS, .PLT, .DXF, need to
be imported and saved as .GNT for Stencil-Art use).

Click on the File | Import menu and choose the “EPS” file format. Find the FLOWER.EPS
file. It will be in the Stencil-Art folder. You can preview the file by double-clicking on its
name.

Select Save and enter the name FLOWER and description “Country tulip”. The new file will
be saved in a permanent graphic library (for the tutorial, select the main Stencil-Art folder).
Click on the “Save” button again.

Bringing the .GNT to the System

In a new sign, select T for text and press the [F4] key to enter the Graphic Selection screen.
Double clicking lets you preview files. Select the FLOWER graphic and confirm. Your
graphic can be treated and manipulated like text.
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Stencil-Art Tutorial
Smoothing the .GNT curves in ICU Mode *

Resize the graphic to about 80% of the drawing height. Select the ICU Mode (Interactive
Curve Utility) from the Transform menu. This feature will help you smooth some curve
intersection problems.

When the ICU Mode is initiated, the graphic is redrawn in gray and the first path becomes
active. The active path is drawn in green with orange nodes marking the curve transitions
that can be automatically smoothed.

In ICU mode, pieces are selected similar to the way lines are selected in the design mode.
HOWEVER, hold the [Ctrl] key down when clicking inside of a piece. Pieces will turn green
when selected. If the active piece has no problem areas, no orange nodes will be
displayed. If you want to smooth a node, click on it. Sometimes a node will need
smoothing more than once.

Notice that the Interactive Curve Utility not only smoothes curves but also applies the
changes to the paths of all affected pieces.

Tip: If you need to create visual depth layers in your graphic, start smoothing the top layer
and work your way down.

When done, select the Save GNT option from the ICU Mode menu and save the graphic
under the same name - FLOWER.GNT. Exit the ICU Mode.

You have the first element in your permanent graphic library.

Sizing the Image, Stretching and Placing

Start a new sign. Bring up the graphic (use T for text and [F4]). Drag the graphic to its
place in your sign, then size and stretch it to its real dimensions before bursting. Color the
graphic to something appropriate for most pieces. This minimizes the work to spot color the

remaining pieces.

Bursting the Image and applying Lead Line relief *

Select the Transformation | Burst Graphic menu. The burst graphic feature “ungroups” the
image so that each piece in the picture can be individually edited. Use C for color and
assign bright red to 2 flower petals and dark red to the remaining 3. Lines (parts) can be
edited one at a time or be selected for group editing. The left mouse can be dragged
around multiple parts which are then group highlighted. Pieces can be added to or removed
from the group by holding the [shift] key and clicking the left mouse on pieces near the
perimeter. The center of shapes will probably not work. Group color, height, text, etc. can
then be changed.

Select the Edit | Group | Edit menu. The burst graphic file name appears in every line. The
first and last lines of a burst graphic have no number in front of the file name and will not be
actively selected by default. All other lines will have an individual piece number in front of
the graphic file name.

For stained glass, confirm the group selection to include all pieces and apply 1/8 inch Lead
Line relief (press L for Lead Line and type 0.125). Then select Wire Frame | Off from the
View menu to see the flower shaded (in-filled). For sign making with no lead line relief, the
pieces will be butt fit.
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Level Four

Color Layer Separation

Select the Edit | Select Lines menu. Click on the Clear All button. Be sure the Toggle
option is selected. Click on the desired color in the first column of the Line List. All lines
having the color will become selected. If you need to turn on/off individual lines, click on the
third column of the Line List at the appropriate row.

For the tutorial, select the dark red pieces and confirm the selection. The display will show
only the dark red petals. If you have bright red and dark red film you can cut the flower by
color layer.

For some applications, pieces should be nested to conserve material which will require
more labor to install pieces one at a time. With a color group selected, use [Ctrl + C] to
copy the lines and then drag the group away from the master layout. Pieces can then be
moved closer together. Use Set Window and Window Output for production.

Cutting Sand Blast Masks

Lead line relief can be used for piece separation in sand blasting. However, for staged
depth and carving, you may not want any relief between neighboring pieces. But do we
want to cut all of the adjoining lines twice?

No! There is a solution to this problem using the export to an .EPS file. During the file
export you will be prompted to Eliminate Double Lines. If you answer Yes, this will result in
creating an .EPS file, very similar to the one you already have, only all duplicate lines will be
eliminated. When you import the .EPS file back into Stencil-Art, do not expect to use the
graphic burst function since pieces will no longer be closed shapes. However, you will have
a perfect sandblast mask!

To learn more about the File | Export .EPS feature, refer to the Users Guide.

The Transform Project Resize can be used to resize a graphic. Select only one piece of a
graphic...Project Resize will then scale the width and height of ALL related graphic pieces
to new dimensions. Refer to the Transform Menu in the Users Guide.
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